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Preface 

 

Ground, surface, and canopy fuel characteristics serve as essential inputs to computer models of fire 

behavior and fire effects.  FuelCalc is a fuel characteristics simulation software program that calculates 

initial canopy fuel characteristics and quickly simulates the effects of thinning, pruning, piling and 

broadcast burning on ground, surface and canopy fuel characteristics.  Consequently, FuelCalc is useful 

for planning fuel treatments, as well as for estimating the effects of wildfire on surface and canopy fuel 

characteristics.  FuelCalc works by simulating changes in ground, surface, piled, and canopy fuel loads by 

size class as fuel treatments add to, or subtract from, the load in each class.  Input files can be either 

created in the monitoring software tool FFI (FEAT/FIREMON Integrated; 

https://www.frames.gov/partner-sites/ffi/ffi-home) or by manually creating an input file in FuelCalc’s 

standard format.     

 

FuelCalc was developed for fire planners to: 

• Calculate canopy fuel characteristics from an existing treelist; and 

• Simulate the effects of fuel treatments and fire on ground (duff and other below surface fuel), 

surface, and canopy fuels. 

Prerequisites 

 

Before using FuelCalc, you should have a working knowledge of fuel characteristics, fuel treatments, and 

fire behavior. Because FuelCalc uses input files from FFI, some knowledge of the means by which FFI 

generates output files will be useful.  Many FuelCalc processes are based on the First Order Fire Effects 

Model (FOFEM) consequently, familiarity with FOFEM will increase the understanding of FuelCalc 

outputs.  Likewise, familiarity with the BehavePlus fire behavior prediction system may increase an 

understanding of the algorithms used for calculating FuelCalc outputs. 

Obtaining copies 

 

Copies of FuelCalc and its associated user documents can be obtained on the FuelCalc homepage: 

https://www.firelab.org/project/fuelcalc.   

 

Credits 

 

FuelCalc was conceived by Elizabeth Reinhardt and Joe Scott, and initially funded through a grant from 

the Joint Fire Sciences Program.  Additional financial support was provided by the U.S. Forest Service 

Fire and Aviation Management, U.S. Forest Service Research and Development, Rocky Mountain 

https://www.frames.gov/partner-sites/ffi/ffi-home
https://www.firelab.org/project/fuelcalc
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Research Station (RMRS) Science Integration and Applications Program, the RMRS Missoula Fire Sciences 

Laboratory, and the Fire Modeling Institute.    

 

Larry Gangi is the primary software contractor.  The FuelCalc User’s Guide was originally written by 

Heather Heward, Duncan Lutes, Robert Keane, Joe Scott, and Larry Gangi, and was edited by Christine 

Frame. User Guide updates provided by Duncan Lutes. 
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Citing FuelCalc and the FuelCalc User’s Guide 

Duncan Lutes. 2020. FuelCalc User’s Guide (version 1.7). Available: 

https://www.firelab.org/project/fuelcalc.  

About the FuelCalc User’s Guide 

Before you begin 

This user’s guide describes the basic operation of FuelCalc and does not repeat instructions specific to 

other software related to FuelCalc: FOFEM, FFI, and BehavePlus (as well as Microsoft Windows in 

general).  Instead, you are encouraged to refer to the help functions available with these programs 

should more detailed questions arise.  

How to use this guide 

By reading the entire user’s guide, you will have complete knowledge of FuelCalc’s function and 

operation.  Additionally, this user’s guide is organized so that you can either 1) learn to use FuelCalc by 

reviewing the guide and learning about each feature and tip, or 2) you can use the guide as a “quick 

reference” by simply navigating to the specific information in which you are interested (note that some 

information is repeated between sections so that sections are relatively self-contained).  Wherever 

appropriate, screen captures are used to illustrate the steps required to complete a task.  

https://www.firelab.org/project/fuelcalc
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Introduction to FuelCalc 

FuelCalc is a software system for assisting local and regional fuel management planners and related 

resource specialists (silviculturists, for example) in designing and implementing fuel treatments in forest 

stands.  The inherent spatial scale of FuelCalc is the plot or sample point (small group of integrated 

plots).  As you will see later in this guide, FuelCalc inputs are provided to FuelCalc for each plot in a 

FuelCalc project.  A FuelCalc project is simply a collection of data for one or more plots, plus information 

regarding associated fuel treatment scenarios and other FuelCalc settings.   A project is commonly 

represented by all of the plots within a stand that is proposed for treatment.  However, a project can 

also represent a collection of unrelated plots to be analyzed individually.  Using meaningful codes to 

identify each plot in FuelCalc will allow the FuelCalc results to be analyzed in a number of ways. The 

number of plots allowed within a FuelCalc project is limited by computer resources; multiple projects 

may be necessary when dealing with more than 100 plots. 

FuelCalc has two primary applications.  First, FuelCalc is a tool to calculate current, or initial, canopy fuel 

characteristics at an inventory plot.  The only input required for this application is a treelist—a listing of 

the characteristics of trees measured on a forest inventory plot.  The required tree characteristics for 

use in FuelCalc include: tree species, diameter at breast height, tree height, crown base height, crown 

class (crown position), tree status, and the number of trees per acre represented by each tree in the 

treelist. These tree characteristics will be described in later sections. 

Second, FuelCalc is a tool for simulating the effects of a fuel treatment—thinning, pruning, pile burning, 

and broadcast burning—on ground, surface and canopy fuel characteristics. In addition to the treelist 

inputs mentioned above, simulating the effects of a fuel treatment on canopy fuel characteristics 

requires a quantitative description of the treatment, including the type and intensity of thinning, the 

height of pruning, how much existing or activity fuel is to be piled, and the nature of a broadcast burn. 

Any combination of these four fuel management activities can be specified.  In order to also simulate 

the effects of a fuel treatment on ground and surface fuel characteristics, FuelCalc requires a description 

of initial ground and surface fuel load, by size class.  These initial ground and surface fuel inputs are 

described in later sections of this guide. 

In addition to the primary functions mentioned above, FuelCalc also has ancillary functions that may be 

useful to fuel management planners and silviculturists.  From the initial surface fuel loads and from the 

loads after simulation of a fuel treatment, FuelCalc suggests a surface fire behavior fuel model (FBFM) 

that may be appropriate for the situation.  If the fuel treatment simulation includes a broadcast burn, 

FuelCalc estimates fuel consumption and smoke production. FuelCalc also calculates several summary 

characteristics based on the initial or simulated treelist that may be useful to the fuel treatment planner, 

silviculturist, or even wildlife biologist, including stand height, stem density, Stand Density Index (SDI), 

canopy cover, basal area, quadratic mean diameter, and quadratic mean diameter 75th percentile.  Each 

of these stand measurements is described in later sections of this guide. 

FuelCalc is not a temporal simulation system; it does not simulate the effects of forest growth, litterfall 

(deposition), and decomposition on surface or canopy fuel characteristics.  The Fire and Fuels Extension 
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to the Forest Vegetation Simulator (FFE-FVS; https://www.fs.fed.us/fvs) is the best tool to use for that 

application.  Although FuelCalc simulates tree mortality, fuel consumption, and emission production, it is 

not the best available tool for those tasks unless the simulation of thinning, pruning, or pile burning is 

also required.  In cases where the simulation of thinning, pruning, and pile burning is not required , 

FOFEM is a better software system for simulating tree mortality and fuel consumption because it allows 

for more details and guidance for both inputs and outputs. 

 

Installing FuelCalc 

• Go to https:\\www.firelab.org and navigate to the Science Applications window and download 

the FuelCalc installation file. 

• Double–click Setup.exe to initiate the installation (Forest Service users need to Run Elevated) 

• On the “Welcome to the FuelCalc Setup Wizard,” click Next. 

• Select a location for the installation of FuelCalc and click Next. 

• Confirm the installation and click Next. 

• When the installation is complete, click Close. 

https://www.fs.fed.us/fvs
https://www.firelab.org/
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The FuelCalc Interface 

 

Figure 3-1: FuelCalc interface with labels to identify the sections of this guide where they are discussed. 

Note: By hovering your mouse over many of the terms on the FuelCalc interface, a “tool-tip” will 

appear with a short description of the term including the units, if applicable.    White colored 

fields can be edited.  Other fields represent model outputs and cannot be changed. 

The main FuelCalc window is somewhat different than many other software applications in that all of 

the main input and output fields are contained within a single screen.  This design allows you to quickly 

simulate fuel treatment effects over many alternative fuel treatments and among many sample plots.  

The Main Menu allows you to open and save projects, input data, view reports, view and edit graphs, 

change FuelCalc options, and access the FuelCalc Help Utility.  

The Plots and Projects section of the user interface allows you to select the plot you wish to view and 

shows you the folder location of the plot and project file.  

The Treelist table displays the tree records for a plot in your input file and contains columns for Thinned 

and Killed, which become populated after treatment has been applied.    
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The Canopy Bulk Density Graph shows the CBD (kg/m3) on the site pre-treatment (blue) and post-

treatment (orange).   

The Stand Measurements characterize pre- and post-treatment stand conditions for a plot. Pre-

treatment measurements are calculated from the treelist by FuelCalc when a plot is initially selected; 

post-treatment measurements are calculated after treatment has been applied.   The pre- and post-

treatment measurements will be identical if a treatment is not applied.   

Torching and crowning indices are displayed for assessing crown fire potential. Crown index is the 20-

foot windspeed at which active crown fire is possible for the specified fire environment. Torching index 

is the 20-foot windspeed at which crown fire activity can initiate for the specified fire environment.  

Timber Volume is expressed in 3 different units (that is, cubic feet, merchantable cubic feet, and 

merchantable board feet) and is displayed for both standing and harvested timber.   

Fuel Loads are expressed as tons/acre.  Pre-treatment fuel loads are derived directly from the input file.   

Five post-treatment fuel load outputs are available, depending upon the treatment scenario selected 

(piled, thinning, pruning, post-burn, and post-treatment).   

Treatment scenarios are developed by selecting Treatment Options.   To activate the Thinning, Prune, 

Pile, and Broadcast burn treatments, simply check the box next to the title.  If the box is unchecked, the 

treatment will not be applied to the stand when you click Calculate.   

The Fire Behavior Fuel Model Selector identifies the pre- and post-treatment fire behavior fuel models 

(FBFM).  You have the option to select either the Anderson (1982) or Scott & Burgan (2005) models, as 

well as filter the output by arid or humid models.  
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Main Menu 

The FuelCalc Main Menu (Fig. 4-1) is where many features of the program are controlled, including 

opening and saving projects, importing input files, generating reports and graphs, setting FuelCalc 

options, and accessing help.  

File menu 

 

Figure 4-1: File drop-down menu 

Open Project / Save Project  

A FuelCalc project is simply a collection of data for one or more plots, plus information regarding 

associated fuel treatment scenarios and other FuelCalc settings.   A project is commonly represented by 

all of the plots within a stand that is proposed for treatment.  However, a project can also represent a 

collection of unrelated plots to be analyzed individually.  Selecting Save Project will save the input data 

file assignment, the current state of any FuelCalc settings, including Treatments, Retention Priorities, 

Species Priorities (on the Settings page) and selections in the Treatment Options section of the user 

interface. The information is saved as an .fcp file.  This file contains information on treatment and other 

settings, but not the input data itself.  Instead, the .fcp file contains a link to any input files used for the 

project. By saving your project, you can return to your work by clicking on Open Project. 

.  
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FFI (FEAT/FIREMON Integrated) Input 

The ecological monitoring program FFI allows export of tree and fuels data that can be imported into 

FuelCalc.  In FFI, the FuelCalc input files can be created by on the Reports and Analysis navigation bar. 

On the Settings tab users determine which macro plots and monitoring statuses to include in the file 

and then export the data on the FuelCalc/FOFEM Export tab (Figure 4-2). 

 

Figure 4-2: The FuelCalc/FOFEM export option in FFI. 

 

The FFI export utility creates two file types: .ffi and .tre.  The .ffi file includes summarized ground and 

surface fuel data.  The .tre file includes tree records for the selected plots.  The same prefix is used for 

both files (for example, Plot 1.ffi and Plot 1.tre).  Files can be saved in any folder. Initially, FuelCalc will 

look for files in the C:\Users\username\AppData\Local\FuelCalc folder.  

Field names, descriptions, and data sources for information in the .ffi file can be found in Appendix A.  

Data are exported from both the English and metric data collection protocols in FFI. Data from metric 

protocols are converted to English units for import to FuelCalc.     

The FFI .tre file includes data from the FFI Trees data collection protocol or the Trees – Individual, Trees 

– Saplings, and/or Trees – Seedlings protocols.  The field names and descriptions for a .tre file are listed 

in Appendix A.    

FuelCalc contains a sample .ffi file with installation so that you can explore the FuelCalc interface and 

functions before creating an input file of your own.  By selecting File > Input FFI, the Select FFI Plot Input 

dialog box will automatically open to the location of the .ffi file.   
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Exit 

Select File > Exit from the main menu to exit the FuelCalc program. FuelCalc will prompt you to confirm 

that you want to exit the program and will also prompt you to save your settings as a project before 

exiting, even if you have just done so. Clicking on the “close” button in the upper right had corner of the 

FuelCalc window will close FuelCalc without properly exiting; you will not be offered the opportunity to 

save your work. 

Report menu 

FuelCalc reports display the information presented on the main FuelCalc window in a format that is easy 

to print or save.  The reports do not contain information on the treatments used to create the potential 

site conditions. You can view the Plot and/or Tree Report.  The Tree Report includes only trees from the 

active plot displayed on the main FuelCalc window.  To see tree reports from other plots, use the plot 

drop-down menu to select a new plot and then run the Tree Report again.  Plot and tree data can also 

be exported in CSV format. 

Graph menu 

FuelCalc generates several graphs for the fuel stand and a graph for the emissions if broadcast burning is 

selected as a treatment.  The fuel stand graphs clearly display the pre-treatment, post thinning/pruning, 

post piling, and post burn for litter and down woody material.  The percent removed is displayed in pie 

charts for the stand measurements and the timber volume; a stand watch is also available, which allows 

for the comparison of the pre-treatment conditions of a selected stand measurement to several post-

treatment scenarios. The emissions graph displays the predicted amount of emissions during the flaming 

and smoldering phase of a broadcast burn. These graphs can be used in reports and for comparisons 

between treatments and plots.  See the Graph section for more detailed information on the FuelCalc 

graphs.  

Options menu 

The Options menu is where the FuelCalc settings can be adjusted, the plot summaries can be created 

and displayed, the equations table can be displayed, and the display of the FuelCalc can be adjusted.   

The Settings option allows the user to create and save different treatments and to specify the desired 

retention priority for the plot.  Plot summaries can then be created as a way to store, transfer, and 

display the results of the FuelCalc calculations. The Equations Table displays the fuel component 

biomass scientific reference for the tree species that are recognized by FuelCalc.  The Color Setting and 

Show Fuel Model checkboxes are used to adjust the display of the main FuelCalc window.  For more 

detailed information on the options menu, go to Options. 

Help menu 

This Help utility contains the information presented in this User’s Guide but is embedded within the tool 

and includes an associated search function. 
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Plots and Project Files 

The plots and project files section of the main FuelCalc window consists of three items: a Plot drop-

down list, a text box indicating the name and location of the plot file and a text box indicating the name 

and location of the project file (Fig. 5-1). 

 

Figure 5-1: Plot, Plot File, and Project File menus located at the top of the main FuelCalc window. 

Plot 

In the Plot drop-down menu, you can select the plot to display and treat according to the selected 

treatment scenario.  These plots were specified in the project or from the FFI inputs.  After you have 

finished with one plot, another plot can be selected and the treatment specifications will stay the same 

so that you can see how that same treatment affects other plots.  In other words, treatments will be 

applied to all of the plots in the input file.     

Plot file 

The Plot File field of the user interface identifies the pathway to the input data.   The Plot File field on 

the main window is present so that you can quickly determine the name of the input file to which the 

data on the main window correspond.  

Project file     

The Project File field of the user interface displays the path to and name of the project file.  This field 

remains blank until a project is saved.  
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Treelist 

The Treelist (Fig. 6-1) identifies all of the trees on a plot by each individual tree, or groups of similar 

trees.  Each tree or group of trees is attributed by species, height, diameter at breast height (DBH), 

crown base height, canopy class, tree status, and tree density (Table 6-1).  For example, in the main 

FuelCalc window, one record (which is a row) in the treelist can be one tree with a unique set of 

characteristics (DBH, HT, CBD), or it can be multiple trees all of which have those characteristics.   

Multiple trees within a group are specified using the tree density field (see TPA on the main window). 

The retention priority column is used to display the current retention priority for the individual trees and 

the columns for Thinned and Killed are outputs that are populated after a treatment has been 

performed.    All outputs from FuelCalc are reported at the plot level, but are summarized on a per area 

(acre-1) basis. 

A Treelist is created using the .tre file format (and associated .ffi file) as shown in Appendix A or can be 

exported out of the FFI application.  It is possible to manually edit records in the Treelist; however, you 

cannot add new records. Modifications made in the tree grid will not be saved in the .tre file. For 

permanent changes modify the .tre file, instead. 

Tree records can be temporality removed from calculations by clicking the small gray area to the left of 

the row, to highlight the row, and clicking the Calculate button. Use Control-Click to select multiple 

rows. To restore calculation to the entire treelist, click anywhere in the tree grid to un-highlight rows 

and click the Calculate button. 

Tip: Treelist records can be sorted in ascending or descending order by clicking on the following 

field headings: Tree Number (Num), Species, Crown Class (CrCl), and Tree Status (TS).  

 

Figure 6-1: Treelist variables and units. Rows that are grayed out, such 

as dead trees, will not be included in any calculations. 
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Table 6-1: Treelist table on the main FuelCalc window. 

Treelist input Description Native units 

Number Row number number 

Species Species code NRCS code 

DBH Diameter breast height inches 

TH Tree height feet 

CBH Canopy base height feet 

CrCl Crown class category 

TS Tree status category 

TPA Tree density stems per acre 

RP Retention priority number 

Thinned Trees removed by thinning stems per acre 

Killed Trees removed by fire stems per acre 

 

Num  

This is an integer value row identifier.   

Species (Tree Species) 

FuelCalc species codes are 4- to 6-character alphanumeric codes developed by the Natural Resource 

Conservation Service (NRCS; http://plants.usda.gov/java/).  FuelCalc uses a subset of the NRCS codes to 

assign crown and bole biomass for each tree record in the Treelist.  If a project includes a tree species 

code that has not been assigned crown and bole biomass equations, FuelCalc will display an error when 

the Calculate button is clicked.  Species codes available in FuelCalc are shown in the file named sample-

species.csv in the in the application installation folder (default is here: 

C:\Users\username\AppData\Local\FuelCalc). To create a sample species select Options>Equation Table 

and click the button to create a Sample Species File. See Appendix C for more information about editing 

sample-species.csv. 

DBH (Diameter at Breast Height) 

Diameter at Breast Height (DBH) refers to the outside-bark diameter, in inches, of the tree measured 4.5 

feet above the forest floor on the uphill side of the tree.  Tree DBH is used to estimate a tree’s crown 

biomass, which is subsequently used to estimate canopy fuel characteristics. For trees less than 4.5 feet 

tall set DBH=0.1 inches. 

 

 

 

http://plants.usda.gov/java/
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TH (Tree Height) 

Tree Height (TH) refers to the vertical distance, in feet, from the ground to the top of the tree stem.  

Tree height is used to distribute biomass vertically along each tree’s crown length, and, in conjunction 

with the height of other trees on the plot, to determine a plot’s overall stand height. 

CBH (Crown Base Height) 

Crown Base Height (CBH) refers to the vertical distance, in feet, from the ground to the lowest height 

above the ground where an individual tree contains enough available fuel to propagate fire vertically 

through its crown.  This definition includes any ladder fuel, such as needle drape or moss, associated 

with the tree.  As with tree height, Crown Base Height is used to distribute biomass along a tree’s crown 

length. 

CrCl (Crown Class)   

Crown Class (CrCl) refers to the crown position of each tree.  Crown Class is used to adjust the estimated 

biomass for each tree and to prioritize trees for removal.  The available crown classes are: 

D – Dominant - A tree whose crown extends above the general level of the main canopy of 

even-aged stands or, in uneven-aged stands, above the crowns of the tree's immediate 

neighbors and receiving full light from above and partial light from the sides  (SAF 2008). 

C – Co-dominant - A tree whose crown helps to form the general level of the main canopy in 

even-aged stands or, in uneven-aged stands, the main canopy of the tree's immediate 

neighbors, receiving full light from above and comparatively little from the sides (SAF 2008).    

I – Intermediate - A tree whose crown extends into the lower portion of the main canopy of 

even-aged stands or, in uneven-aged stands, into the lower portion of the canopy formed by 

the tree's immediate neighbors, but shorter in height than the co-dominants and receiving 

little direct light from above and none from the sides (SAF 2008). 

E – Emergent * - A tree whose crown is completely above the general level of the main 

canopy, receiving full light from above and from all sides (SAF 2008). 

S – Suppressed - A tree whose crown is completely overtopped by the crowns of one or more 

neighboring trees; note that the vigor of overtopped (suppressed) trees varies from high to 

low depending on individual circumstances (SAF 2008). 

O – Open Grown * - Tree crown receives full sunlight from above and all sides (ECODATA 

1987). 

N – None/Unknown 

 

*These classes are not included in .ffi input files (See Appendix A for more information). See Appendix D 

for more information on the canopy reduction factors used in FuelCalc. 
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TS (Tree Status)  

Tree Status (TS) refers to the health of the tree stem in the Treelist.  This variable is used to prioritize 

trees for removal during a thinning.  The four possible tree health status categories are: 

H – Healthy - Tree with very little biotic or abiotic damage (Lutes and others 2006). 

U – Unhealthy - Tree with some biotic or abiotic damage, and this damage will reduce growth.  

However, it appears the tree will fully recover from this damage (Lutes and others 2006). 

S – Sick - Tree with extensive biotic or abiotic damage, and this damage will ultimately cause 

death within the next 5-10 years (Lutes and others 2006). 

D – Dead - Tree with no observable living tissue (Lutes and others 2006). Dead tree records 

appear as gray rows in the Treelist and are not included in any calculations. 

TPA (Trees per Acre)  

Trees per Acre (TPA) refers to tree density of the Treelist record or the number of trees per acre 

represented by the tree record.  FuelCalc uses this input to weight the contribution of each tree record 

in summarizing plot-level characteristics.  For example, if two healthy whitebark pine trees of 10 inches 

DBH, 50 feet tall, and having codominant crowns 10 feet high were sampled on a 0.1-acre plot, then the 

number 20 would be entered for TPA. 

RP (Retention Priority) 

The Retention Priority (RP) column displays the retention priority value calculated from the Options > 

Settings window.  Retention priority can be set between 0.1 and 1.0. Trees with low retention priority 

are removed first. There are also two special codes. Trees with retention priority of 0.0 will always be 

removed and trees with retention priority of 99 will always be retained.  A complete description of 

retention priority with examples can be found in Retention Priority Factors in the Options section.  

Thinned  

The Thinned column displays the number of trees per acre that were removed from the plot during the 

thinning treatment; this is not affected by the broadcast burn treatment (that is, trees not selected for 

thinning can be killed by prescribed burning).  More information on how thinning treatments work in 

FuelCalc can be found in the Thinning section.  

Killed  

The Killed column displays the number of trees per acre that were simulated to die during the broadcast 

burn treatment as specified in the Treatment Inputs; this number does not include any thinned trees.  

Fire-caused tree mortality simulated in FuelCalc is a function of species, crown scorch, and tree 

diameter.  Mortality equations and other tree mortality algorithms and parameters were taken from the 

FOFEM computer model, thus their details are provided in the FOFEM User’s Guide (Reinhardt and 

others 1997).    
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Canopy Bulk Density Graph  

 

The Canopy Bulk Density (CBD) graph (Fig. 7-1) is a vertical profile of canopy bulk density (see Canopy 

Bulk Density) in kilograms per cubic meter (kg/m3).  Pre-treatment stand conditions are shown in blue 

and post-treatment stand conditions are shown in orange.   

 
Figure 7-1: Canopy Bulk Density graph. 

Note: CBD is the only value in FuelCalc displayed in metric units; this is done to follow standard 

practice in fire behavior modeling systems.  All other values in FuelCalc are displayed in English 

units. 

Stand Measurements 

Pre-treatment stand measurements (Fig. 8-1) are calculated from the information entered in the initial 

Treelist and will remain constant throughout the treatment process.  Post-treatment stand 

measurements are re-calculated after each treatment application and are based on the initial Treelist 

and the treatment options selected (Table 8-1).  

 

Figure 8-1: Stand Measurements table. 
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Table 8-1: Table of stand characteristics and native units in the stand measurements table.  

Characteristic Description Units 

CFL Canopy Fuel tons/acre 

CBD Canopy Bulk Density kg/m3 

CBH Canopy Base Height feet 

CSH Canopy Stand Height feet 

TD Tree Density trees/acre 

SDI Stand Density Index number 

CC Canopy Cover percent 

BA Basal Area ft2/acre 

QMD Quadratic Mean Diameter inches 

Q75 Quadratic Mean Diameter (75th Percentile) inches 

 

Note: By default, hardwood trees input to FuelCalc are not considered in canopy fuel 

calculations (CFL, CBD, CBH, and SH) since in most cases they do not contribute significantly to 

crown fire activity.  For the instances where this is not the case, the species file can be changed 

to include hardwood trees in the calculation of canopy fuels by following the directions in 

Appendix C.   

CFL - Canopy Fuel Load 

The plot-level available Canopy Fuel Load (CFL) is the sum-product of available adjusted crown fuel mass 

and trees per acre for every tree in the Treelist.  Available adjusted crown fuel mass includes the load of 

all of the tree foliage and 50 percent of the tree’s twig (0- ¼ inch) branch material adjusted for crown 

class (Scott and Reinhardt 2001). 

CBD - Canopy Bulk Density   

Canopy Bulk Density (CBD) refers to the mass of CFL per unit canopy volume (Scott and Reinhardt 2001) 

in kilograms per cubic meter.  

FuelCalc estimates an effective plot-level CBD as the maximum 5-foot running average CBD that occurs 

in the profile. 

CBH - Canopy Base Height  

FuelCalc calculates Canopy Base Height (CBH) as the lowest height above the ground at which CBD is 

greater than or equal to a calculated Threshold CBD.  The maximum Threshold CBD used is 0.012 kg/m3, 

which works well in most situations.  However, this threshold value is not ideal in stands with low CBD 

(for example, in stands that have been extensively thinned or in a naturally open stands).  We addressed 

this issue in FuelCalc by calculating Threshold CBD as the maximum stand-level CBD * 0.1 for CBD values 
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up to 0.12 kg/m3.  Using this approach, the Threshold CBD for determining CBH is equal to 1/10th the 

CBD up 0.12 kg/m3, after which the Threshold CBD is held at the maximum: 0.012 kg/m3 (Fig. 8-2). 

 

Figure 8-2: Threshold Canopy Bulk Density used for determining canopy base 

height and stand height. 

SH - Stand Height 

FuelCalc calculates plot-level stand height as the maximum height where calculated CBD exceeds the 

same Threshold CBD value used for determining CBH. Double-clicking the CBH or SH value in the Stand 

Measurements table will display the CBD Threshold value (Fig. 8-3).   

  

Figure 8-3: This box will appear when the CBH or SH fields are 

double-clicked.  It displays the threshold value used to calculate CBH 

and SH. 

TD - Tree Density  

Tree Density (TD) refers to the number of trees per acre on the plot.  It is calculated as the sum of the 

TPA values for each tree record in the Treelist.  All live trees, regardless of diameter, are included in this 

measure. 
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Tip: If there is a tree record that you wish to exclude from the calculations, highlight the row(s) in 

the treelist of the record you wish to exclude and click Calculate.  The selected tree records will 

be excluded in any stand measurement and timber volume calculations, nor will they be included 

in or affected by treatments (Fig. 8-4).   

 

Figure 8-4: This box will appear when a tree record is excluded from 

the calculations. 

SDI - Stand Density Index 

Stand Density Index (SDI; Reineke 1933) is a measure of stand density that combines stem density and 

Quadratic Mean Diameter (QMD).  SDI represents the density of trees per unit area that an even-aged 

stand would have at a standard average DBH (25 cm). 

CC - Canopy Cover  

Canopy Cover (CC) refers to the non-overlapping fraction of the vertical projection of tree crowns that 

cover the plot.   

BA - Basal Area  

Basal Area (BA) represents the outside-bark cross-sectional area per acre of live tree stems, measured 

4.5 feet above the ground. 

QMD - Quadratic Mean Diameter  

Quadratic Mean Diameter (QMD) is the square root of the arithmetic mean of the squares of the tree 

diameters on a plot (the root-mean-square diameter).     

Q75 - Quadratic Mean Diameter 75th Percentile  

Quadratic Mean Diameter 75th Percentile (Q75) refers to the QMD of trees in the largest 75th percentile 

by basal area.   
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Torching and Crowning Indices 

Torching index is the 20-foot windspeed at which crown fire activity can initiate for the specified fire 

environment. It is a function of surface fuel loading and composition, surface fuel moisture, canopy base 

height, slope and wind reduction due to canopy. Crowning index is the 20-foot windspeed at which 

active crown fire is possible for the specified fire environment. It is a function of canopy bulk density, 

surface fuel moisture and slope. The indices can be used as a measure of potential fire behavior where 

fuel treatments that increase torching index and crowning index indicate reduced probability of crown 

fire activity. Maximum wind speed displayed for either index is 100 MPH. The torching and crowning 

index section of the user interface is shown in Figure 8.5. 

 

Figure 8.5: Pre-treatment and post-treatment torching and crowning index 

are displayed on the user interface. Clicking the Moistures button will 

display the moisture values used in Nexus for the calculation of the 

values. 

FuelCalc links directly to an imbedded copy of Nexus (Scott 1999) to calculate crowning and torching 

index. FuelCalc produces a custom fire behavior fuel model that includes fuel loading of 1-hr, 10-hr, 100-

hr litter, shrub and herbaceous biomass; surface area to volume ratios for 1-hr, herb and shrub; fuelbed 

depth; dead fuel moisture and heat content. Fuel load and surface area to volume ratios come directly 

from the FuelCalc user interface. Dead fuel moisture of extinction and heat content are set to 25% and 

8000 BTU lb-1, respectively. Fuelbed depth is calculated using the equations presented in Appendix B.  

Nexus requires percent moisture inputs (gravimetric) for 1-hr, 10-hr, 100-hr, live herb, live shrub and 

foliage. In FuelCalc these moisture settings are linked to the moisture regime set on the user interface 

(Figure 8.6). Table 8.5 displays the relationship of FuelCalc moisture regime and the fuel moisture used 

in Nexus. 

 

Figure 8.6: The FuelCalc moisture regime field. 
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Table 8.5. Relationship of moisture regime set on the FuelCalc interface and the percent 
moisture values used to calculate torching and crowning index in Nexus. 

 Percent Moisture used in Nexus 

Moisture Regime 1-hr 10-hr 100-hr Live Herb Live Shrub Foliar5 

Very Dry1 3 4 5 30 60 100 

Dry2 6 7 8 60 90 100 

Moderate3 9 10 11 90 120 100 

Wet4 12 13 14 120 120 100 
1 Dead fuel moisture = D1 and live fuel moisture = L1; in Scott and Burgan 2005 
2 Dead fuel moisture = D2 and live fuel moisture = L2; in Scott and Burgan 2005 
3 Dead fuel moisture = D3 and live fuel moisture = L3; in Scott and Burgan 2005 
4 Dead fuel moisture = D4 and live fuel moisture = L4; in Scott and Burgan 2005 
5 Nexus suggested default 

 

The user may modify the moisture settings for 10-hr, 1000-hr and duff on the user interface to any 

percent moisture desired and these changes will modify the fire effects simulated in FuelCalc; however, 

the percent moisture for components used simulate fire behavior in Nexus and shown in table 5.8 are 

always linked to the moisture regime setting (Very Dry, Dry, Moderate, Wet). To see the moisture values 

used to calculate torching and crowning index click the Moistures button (Figure 8.5). 
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Timber Volume 

In FuelCalc, all of the timber volumes (Fig. 9-1) are calculated using the National Volume Estimator 

Library (NVEL; https://www.fs.fed.us/fmsc/measure/volume/nvel/index.php). FuelCalc uses 

general species specific equations so consider the volume estimates approximate values. Volume of only 

live trees is included in the Timber Volume table.  

 

Figure 9-1: Timber Volume table.  

Cubic Ft  

Cubic Feet (Standing and Harvested) refers to the total woody bole volume of all live trees on the plot 

and is measured in cubic feet per acre.  Harvested values are calculated after a thinning treatment has 

been applied.   

M C Ft  

Merchantable Cubic Feet (M C Ft) refers to the merchantable volume of standing or harvested timber on 

the plot measured in cubic feet per acre.  Merchantable volume is less than total volume because small 

trees and tree tops are not merchantable. The FuelCalc estimate of merchantable volume does not 

include any reduction for stem defects. 

M B Ft 

Merchantable Board Feet (M B Ft) represents the merchantable board-foot volume of standing or 

harvested timber on the plot measured in board feet per acre. The FuelCalc estimate of merchantable 

board feet does not include any reduction for stem defects. 

https://www.fs.fed.us/fmsc/measure/volume/nvel/index.php
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Fuel Loads 

Pre-treatment Fuel Load   

Pre-treatment fuel loadings are derived directly from the plot input file (Fig. 10-1).  These amounts can 

also be edited by typing directly into the text box, which is useful for seeing how pre-treatment values 

can influence post-treatment conditions.  Edited values, however, will not be saved in the project file or 

stored back to the input file.      

 
Figure 10-1: Fuel Load table, Pre-treatment row.  All loadings are in tons per acre.  

Duff –The layer of decomposing organic materials lying below the litter layer of freshly fallen twigs, 

needles, and leaves and immediately above the mineral soil (NWCG Online Glossary). 

Herb – Any of a large family of monocotyledonous; mostly herbaceous plants with jointed stems, 

slender sheathing leaves, and flowers borne in spikelets of bracts (Merriam Webster). 

Lichen – Any of numerous complex plantlike organisms made up of an alga and a fungus growing in 

symbiotic association on a solid surface (such as a rock) (Merriam Webster). 

Moss – Any of a class (Musci) of bryophytic plants characterized by a gametophyte having a small leafy 

often tufted stem bearing sex organs at its tip; also: a clump or sward of these plants (Merriam 

Webster). 

Shrub – A woody perennial plant differing from a perennial herb by its persistent and woody stem, and 

differing from a tree by its low stature and habit of branching from the base (NWCG Online Glossary). 

Litter – The top layer of forest floor, composed of loose debris of dead sticks, branches, twigs, and 

recently fallen leaves or needles; little altered in structure by decomposition  (NWCG Online Glossary). 

1-hr  – Dead fuels consisting of dead herbaceous plant material and roundwood less than 0.25 inches in 

diameter estimated to reach 63 percent of equilibrium moisture content in 1 hour or less (NWCG 1994). 

10-hr – Dead fuels consisting of roundwood 0.25 to 1.0 inches in diameter estimated to reach 63 

percent of equilibrium moisture in 10 hours (NWCG 1994). 

100-hr – Dead fuels consisting of roundwood in the size range from 1.0 to 3.0 inches in diameter 

estimated to reach 63 percent of equilibrium in 100 hours  (NWCG 1994). 

1000-hr – Dead fuels consisting of roundwood 3.0 to 8.0 inches in diameter estimated to reach 63 

percent equilibrium moisture content in 1000 hours (NWCG 1994). 
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Sound down woody fuel  – Woody material that is still mostly intact and relatively difficult to break 

apart. Sound woody material has higher wood density than rotten woody material of the same species 

(Brown 1974). 

Rotten down woody fuel – Woody material that is not intact or is easily broken apart. Rotten woody 

material has lower wood density than rotten woody material of the same species (Brown 1974). 

Pile 

Pile represents the load of any piled fuels that may exist on the plot before treatment.  If you have 

created your own input file and have not included information on pile loading, there will be no value 

here.  You can manually enter and change this value, but your change will not be saved to your input 

file.  

Total 

Total refers to the total of all fuel loading, including the piled amount. 

Surface Fuel Piled 

Fuel loading of the individual components is calculated based on percentages entered in the Pile 

treatment area (Fig. 10-2) and include fuels from: 1) the Pre-treatment row (piled using Surface %) and 

2) Post Thinning Slash row and Post Prune Slash row (piled using Slash %).  

 

Figure 10-2: Pile treatment options. In this example, 50% of the pre-

treatment surface fuel and 80% of the activity or slash fuel is piled, and 

90% of the pile is consumed. 

The litter, 1-hr, 10-hr, 100-hr, and 1000-hr fields of the Surface Fuel Piled row (Fig. 10-3) show the load 

of the individual piled fuel components. The last field in the row displays ONLY the total load of piled 

surface fuels and does not include post thinning and post pruning slash.   

 

Figure 10-3: Fuel Load table; circled are the sum of all existing ground fuels that are piled. 
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The total load of piled thinning and pruning slash is included in the Pile column of the Post Prune Slash 

row (Fig. 10-4).  The field in the Total column displays the total thinning and pruning slash and includes 

piled and un-piled slash. 

 
 

 

Post Thinning Slash 

The amounts in the Post Thinning Slash row represent any slash that is created from a thinning 

simulation in tons per acre, not including the material removed and put in piles.  Any piled amounts are 

added to the above corresponding fields in Surface Fuel Piled row.   

Post Prune Slash 

The amounts in the Post Prune Slash row represent any slash that is created from a pruning operation in 

tons per acre not including any piled amounts, which are added to the above corresponding fields in the 

Surface Fuel Piled row.   

Consumed 

The amounts in the Consumed row of the Fuel Loads section are the individual and total fuel loads in 

tons per acre that are consumed during a broadcast burn treatment.  Calculations are based on 

algorithms in FOFEM (Reinhardt and others 1997). Percent piled fuel loading consumed is set in the Pile 

treatment area as described in the Pile section.  

Post Treatment 

The Post Treatment row contains the remaining fuel loads after all treatments have been applied.  See 

Table 11-1 for specific effects of each of the treatments on the different fuel loading inputs 

 Note: The Litter amount includes scorched foliage that is expected to fall within 1-year 

post-fire from any trees damaged in a broadcast burn. 

 

Figure 10-4: Fuel Load table; circled are the total slash piled and the total slash created for both 

thinning and pruning.  
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Treatment Options 

The effects of fuel treatments on surface and canopy fuels are calculated using the surface fuel load 

information you entered and the canopy fuel characteristics calculated by FuelCalc using the Treelist.  

This section describes the process used to define and simulate fuel treatments in FuelCalc. 

In FuelCalc, a fuel treatment is an ordered, sequential regime of fuel management actions.  The actions 

that FuelCalc simulates are, in order: 

Thinning – Cutting or harvesting procedure that reduces stand density (Smith 1986). 

Pruning – Procedure that remove only tree branches (Smith 1986). 

Piling and burning – Manual or mechanical piling of slash resulting from logging or fuel management 

activities and subsequent burning the individual piles (NWCG Glossary). 

Broadcast burning – Prescribed burning activity where fire is applied generally to most or all of an area 

within well-defined boundaries for reduction of fuel hazard, as a resource management treatment, or 

both (NWCG Glossary). 

To activate the Thinning, Prune, Pile, and Broadcast burn treatments, simply check the box next to the 

title.  If the box is unchecked, the treatment will not be applied to the stand when you click Calculate.  

The rare cases in which a different order would produce a different result cannot be simulated.  The 

following sections describe how the characteristics of each treatment action are applied.  The initial plot 

condition (also called pre-treatment or untreated) is simulated by unchecking the box next to each of 

the treatment options.  The potential effects that the four different treatments could have on fuel or 

biomass components are shown in Table 11-1 and summarized in the bulleted list that follows. 

Table 11-1: The potential effects of thinning, pruning, piling, pile burning, and broadcast 

burning on fuel loadings.  The “+” sign means that the fuel/biomass component will be 

positively affected or increase after a treatment. The “-” symbol means that the 

fuel/biomass component will be negatively affected or decrease after a treatment. 

Fuel / biomass 
component Thinning Pruning Piling 

Pile 
burning 

Broadcast 
burning 

Duff 
    

- 

Herb 
    

- 

Lichen 
    

- 

Moss 
    

- 

Shrub 
    

- 

Litter + + - 
 

+ / - 

1-hr + + - 
 

- 

10-hr + + - 
 

- 

100-hr + + - 
 

- 

1000-hr (sound) + 
 

- 
 

- 

1000-hr (rotten) 
  

- 
 

- 

Piled fuel 
  

+ - 
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• Duff consumption is affected only by the moisture scenario, region, and season of 

broadcast burn, which reduces duff load by burning across the plot.   

• Herb will be consumed in any burning conditions specified in FuelCalc. 

• Thinning and pruning both add to the Litter fuel component, even though the needles 

are initially still attached to the branches and not necessarily on the ground; piling 

reduces Litter by adding to piles the needles that are still attached to branches; 

broadcast burning reduces the Litter load (representing an initial drop as it is consumed 

from the ground), but may also increase Litter load (representing the scorched foliage 

that falls to the ground after the burn).   

• The Lichen, Moss, Herbaceous, and Live Woody fuel components are not affected by any 

treatment except burning, which reduces their loads.   

• The 1-hr, 10-hr, and 100-hr timelag size class dead and down fuel components are 

increased by thinning and pruning but decreased by piling and broadcast burning.   

• Thinning adds to the 1000-hr timelag class fuel load (all of it sound) but piling and 

broadcast burning can then reduce this load; piling and broadcast burning reduces the 

load of both sound and rotten 1000-hr timelag class logs.   

• Nothing adds to the load of rotten 1000-hr timelag class fuel because all activity fuel is 

presumed to be in the sound class, and FuelCalc does not simulate decay of fuel from 

sound to rotten over time.   

• Piling adds to any existing Piled fuel load and burning the piles subsequently reduces the 

Piled fuel load.   

The potential effects that the four different treatments could have on stand measures are shown in 

Table 11-2 and summarized in the bulleted list that follows. 
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Table 11-2: The potential effects of thinning, piling, pile burning, and broadcast burning on 

stand measurements.  The “+” sign means that the fuel/biomass component will be positively 

affected or increase after a treatment. The “-” symbol means that the fuel/biomass component 

will be negatively affected or decrease after a treatment.  The “0” symbol indicates that the 

treatment could have no effect on fuel/biomass. 

Stand Measurement Thinning Pruning Piling 
Pile  

burning 
Broadcast 

burning 

Canopy Fuel Load  - -   0 / - 

Canopy Bulk Density  0 / - 0 / -   0 / - 

Canopy Base Height  0 / + 0 / +   0 / + 

Stand Height  0 / +    0 / + 

Tree Density  -    0 / - 

Stand Density Index  -    0 / - 

Canopy Cover  -    0 / - 

Basal Area  -    0 / - 

Quadratic Mean Diameter  -    0 / - 

Q75 0 / -    0 / - 

• Thinning and pruning will always reduce Canopy Fuel Load (CFL); broadcast burning will 

reduce CFL if the fire causes tree mortality or scorch height exceeds crown base height. 

• Thinning either decreases Canopy Bulk Density (CBD) or leaves it unchanged, depending 

on the nature of the stand and the intensity of the thinning.  For thinning to decrease 

CBD, it must remove fuel in the most densely packed layers of the canopy.  Understory 

removal may not reduce CBD if the highest CBD is found in the overstory; overstory 

thinning may not reduce CBD if the highest CBD is found in the understory. 

• Thinning either increases Canopy Base Height (CBH) or leaves it unchanged, depending 

on the nature of the stand and the intensity of the thinning.  For thinning to increase 

CBH, it must remove enough trees that the height to the Threshold CBD is higher in the 

canopy.  High thinning or commercial thinning that leaves small non-commercial trees 

standing may not change CBH.   

• As with CBH, thinning and burning either decreases Stand Height or leaves it unchanged, 

depending on whether trees with taller than the pre-treatment stand height are thinned 

or killed. 

• Tree Density will be affected if trees are thinned or killed. 

• Stand Density Index will be affected if trees are thinned or killed. 

• Canopy Cover will be affected if trees are thinned or killed.   

• Basal Area will be affected if trees are thinned or killed. 

• Quadratic Mean Diameter (QMD) will be affected if trees are thinned or killed.  Removal 

of small trees may not change QMD noticeably. 

• Quadratic Mean Diameter 75th Percentile (Q75) will be affected if the large diameter 

trees are thinned or killed.  Removal of small diameter trees may not change Q75. 
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Treatment Name   

FuelCalc allows you to descriptively name and save your treatment parameters for use in future 

calculations.  Saving treatments allows for quick replication of treatments for different projects (Fig. 11-

1).  Type the name into the box and click save, or click the drop-down arrow and select a previously 

created treatment.  

 
Figure 11-1: The Calculate button, Treatment Name creator 

and selector drop-down menu, and the Retention Priority Set 

drop-down menu. 

 

Retention Priority Set 

This control allows you to select any retention priorities you have previously created.  Information on 

creating retention priorities can be found in Retention Priority Factors in the Settings section. 

Thinning  

Thinning is the commercial or non-commercial cutting of trees (that is, reduction of tree density in a 

forest stand) to meet a forest stand management objective (Fig.11-2).  Canopy fuel load reductions from 

thinning are usually offset by surface fuel load increases in Litter, 1-hr, 10-hr, 100-hr, and 1000-hr 

timelag dead fuel classes (Table 11-1).  

  

Figure 11-2: Thinning treatment box. 
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Thinning drop-down menu 

This group of controls allows you to select the attribute by which you wish to thin.  Figure 11-3 shows 

the available stand measurements you can choose from when creating a thinning treatment.  Note that 

this list of options corresponds to the list of stand measurements in the upper-right area of the user 

interface. See the section on Stand Measurements for detailed definitions of the terms in this menu. 

  

Figure 11-3: Thinning drop-down menu. 

The selection you make here will determine where the following parameters for the treatment will be 

applied.  

Thin To Target  

This is the target value that FuelCalc will try to achieve while simulating a thinning treatment.  For 

example, if you are thinning by tree density and set this value to 100, FuelCalc will remove trees until 

there are 100 trees left on the plot or it has removed every tree it is allowed to remove while operating 

within your specified cutting efficiency and diameter limits.   

Note: This target value must be in the proper measurement units applicable to the thinning 

attribute you have selected (See Table 8-1 for units).  In other words, if, for example, you select 

basal area, the target unit will be in square feet per acre; for canopy bulk density, the target unit 

will be in kg/m3, and so on. 

 

Cutting Efficiency %  

Once the retention priority has been calculated for each tree (see Retention Priority Factors in the 

Settings section for information), the order of removal is from lowest priority to highest.  Cutting 

efficiency represents the percentage of trees that can be removed for each tree record (a single line in 

the treelist).  For example, if you have a tree record (for example, PSME) in the treelist with 10 trees per 

acre (TPA), and the cutting efficiency is set to 80%, then FuelCalc is allowed to remove up to 8 trees; it 

may remove less, but no more.  The default cutting efficiency is 90, meaning that 90% of all trees 

represented by a particular record are removed. 
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Merch dia ≥ (Merchantable Diameter ≥ [inches]) 

Merchantable diameter specifies the smallest DBH of thinned trees that are to be included as 

merchantable timber in the Merchantable Cubic Feet and Merchantable Board Feet fields (see the 

Timber Volume section, instead of just Cubic Feet in the Timber Volume Field.  Thinned tree bole 

material less than the merchantable diameter is left in the stand (shown in the Post Thinning Slash row).     

Top Diameter  

The merchantable top diameter parameter specifies the diameter at which the tree is topped or cut off 

and left in the plot; the remainder of the tree bole is assumed to be brought to the landing and 

therefore counted as Timber Volume.   Set Top Diameter to 0 to simulate whole tree removal from the 

stand.  Biomass in the tree top is activity fuel that affects the Post Thinning Slash and can be specified 

for piling and burning. 

Yard Loss % 

Yard loss % is the portion of cut trees - including branches, limbs and foliage - lost as trees are yarded 

(moved) from where the tree was felled to the landing.  Factors affecting yard loss include the logging 

method and whether landing slash is backhauled to the stand.  For example, a value of 0 percent would 

mean that no amount of slash from the merchantable tree(s) is left on the plot, and the tree in its 

entirety was removed from the plot.  Alternately, a value of 100 percent would mean that all of the slash 

from a merchantable tree is left on the plot.  The biomass is counted as activity fuel, it affects the 

loading of the Post Thinning Slash (that is, slash not moved to the landing), and it can be specified for 

piling and burning. 

<DBH>  

These two diameters globally specify the range of trees that can be thinned.  For example, a setting of 4 

and 12 inches would result in all trees less than 4 and greater than 12 inches being retained from being 

cut, regardless of retention priority and other factors, whereas trees between 4 and 12 inches would be 

harvested.    

The setting is this field overrides DBH settings in the Species Groups. If the Species Groups include 

records with DBH set outside range entered in the <DBH> fields those records will be removed from 

consideration for the thinning simulation. 

Prune 

Pruning is the mechanical removal of the lower branches of trees (Fig. 11-4).   

 

Figure 11-4: Prune treatment box. 
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FuelCalc uses a very simple approach to simulating pruning.  If pruning is included, the only 

characteristics to specify are the pruning height and the minimum residual crown ratio.  All trees are 

pruned to the specified pruning height or the height that maintains the residual crown ratio after 

pruning, whichever is less.  (This prevents pruning a tree to death.) Reductions from pruning are exactly 

offset by increases in Litter and the 1-hr, 10-hr, and 100-hr timelag classes (Table 11-1). 

Pruning does not change Canopy Cover in FuelCalc, but it does change CBH and CBD.  Pruning raises CBH 

as long as the pruning height is greater than the pre-pruning CBH.  Pruning can reduce CBD if the 

pruning height approaches the height of maximum bulk density.  Pruning heights are usually limited to 

relatively low values (for example, < 10-ft).  Consequently, pruning generally reduces CBD only if the 

highest CBD is very low to the ground (in the understory layer, for example).  (See Table 11-2.) 

Height  

If pruning is included as part of the treatment, the maximum height (in feet) of the pruning is specified.  

However, the maximum thinning height may be adjusted by the minimum residual crown ratio percent 

(see below).   

M R C R % (Minimum Residual Crown Ratio Percent)  

The Minimum Residual Crown Ratio Percent (M R C R %) specifies the minimum crown ratio of a tree to 

be maintained after pruning.   For example, if you specify a prune height of 10 feet and an M R C R of 40 

percent, then the pruning height on a 10-foot tree would be only 6 feet, leaving the minimum 40 

percent crown ratio.  In this case, the M R C R prevents FuelCalc from pruning the entire tree crown.  A 

tree would need to be at least 25 feet tall to be pruned up to 10 feet and still have an M R C R of 40% 

Pile 

Pile simulates the piling (for example, hand-piling and machine piling) of fuel in the plot and subsequent 

burning of the piles (Fig. 11-5).   

 

Figure 11-5: Pile treatment box. 

Piling and burning is simulated by specifying the percent of surface fuel piled, the percent of the slash 

fuel piled, and the percent of the piled material that is consumed.  Piling reduces the Litter, and all dead 

and down size classes; the decreases are exactly offset by an increase in the load of Piled fuel.  Pile 

burning reduces the piled fuel load.   

FuelCalc assumes that no trees are scorched or killed when making or burning piles.  Consequently, 

piling and pile burning are assumed to have no effect on canopy characteristics. Emissions for pile burns 
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are included in the total emission production estimate (25% flaming and 75% smoldering) but are not in 

the emission graph. Emissions for burned piled fuels are always estimated using the FOFEM default 

emissions factors with 25% consumption in the flaming phase and 75% in smoldering phase. 

Surface %  

Surface % refers to the percentage of the pre-treatment woody fuel load that is piled.  The remainder 

stays as part of the surface fuel complex.  The Surface % is applied to all size classes of pre-treatment 

fuel. 

Slash %  

Slash % refers to the percentage of thinning and pruning slash that is to be placed on the pile.  This 

includes the topped portions of merchantable trees.  The Slash % is applied to all size classes of slash 

fuel. 

Consumed %  

Consumed % refers to the percentage of piled fuels that will be consumed in a pile burn.  For the fuel 

loading shown in the Pile cell of the Pre-Treatment row FuelCalc consumes the percentage as set in the 

Consumed % field. For piled slash fuels (shown in the Pile cell of the Post Prune Slash row) total 

consumed equals 100% of the litter, 1-hr, 10-hr and 100-hr piled slash loading plus the Consumed % of 

the 1000-hr (>3 inch) piled slash fuel loading. By setting Consumed % to 0, pile burning will not occur 

(emissions for pile burning are not included in the emissions calculations).  The reason the Consumed % 

is applied differently to Pre-Treatment and Slash fuels is because the fuel distribution of the fuels in the 

Pre-Treatment Pile cell is unknown. 

Broadcast Burn 

Broadcast burning is the application of prescribed fire to a whole unit, not just to piles or jackpots in a 

unit (Fig. 11-6).   

 

Figure 11-6: Broadcast Burn treatment box. 

Due to the effects of ignition pattern on fire behavior, FuelCalc does not attempt to simulate the 

behavior of a prescribed fire.  Instead, the user must set Scorch Height, along with the fuel moisture 

content, region, and season of the broadcast burn.  The consumption routine from the First Order Fire 
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Effects Model (FOFEM; Reinhardt and others 1997; Reinhardt 2003) is used in FuelCalc to calculate the 

consumption of the different fuel components.  See the FOFEM Users Guide for details on the algorithm 

decision key used by FOFEM (Reinhardt and others 1997).  Within FOFEM, woody fuel consumption is 

calculated using the Burnup model (Albini and Reinhardt 1995; Albini and others 1995; Albini and 

Reinhardt 1997), and duff, litter, shrub, and herbaceous fuel consumption are calculated from empirical 

equations or through general assumptions.  Broadcast burning reduces all ground and surface fuel 

components and potentially reduces CFL if crown scorch occurs.  Broadcast burning may also increase 

Litter and the 1-hr timelag class if crown scorch occurs.  The net sum of those reductions and increases 

(Table 11-1) is the Fuel Load Consumed. 

Broadcast burning has two direct effects on the canopy: it scorches trees (thereby having a similar effect 

to pruning), and may kill trees (similar to thinning).  Indirectly, these effects can increase CBH, reduce 

CBD, and reduce Canopy Cover just as thinning and pruning do.  Whether these effects take place 

depends on the nature of the broadcast burn (Table 11-2). 

Emissions are the product of consumed fuels and emissions factors. FuelCalc uses the FOFEM emissions 

routine, which includes two sets of emissions factors and associated logic for calculating emissions: 1) 

the Default used in FOFEM for many years and 2) Expanded based on Urbanski 2014. The FOFEM User 

Guide includes a complete discussion of the Default and Expanded emissions factors and the logic used 

to calculate emissions. 

Clicking the Expanded radio button opens a new group box for selecting the emission factors to be used 

for Short Term Flaming and Smoldering, Duff Residual Smoldering Component and Coarse Wood 

Residual Component. Currently, only the Short Term Flaming and Smoldering have optional emission 

factors. The selection will be used for all plots if a batch simulation is run. If plot specific selections are 

desired when simulating multiple plots then the FuelCalc command line batch must be used.  

 

Pre-burn Duff Depth (inches) 

If duff depth is included as part of your input file, the value will be added here, but the value can be 

edited.  Duff depth is included in FuelCalc files exported from FFI; but if you manually create FuelCalc 

files in the FFI format and do not include duff depth, then the field will have a beige background and 

duff depth will be calculated from the duff load (tons per acre) using a ratio of 1 ton of duff load to 0.1 

inches of duff.   

Scorch Hgt (feet)  

Specify the expected or prescribed scorch height.  This value is used to determine tree mortality and 

may therefore affect CBD and CBH. FuelCalc does not calculate emissions from scorched crowns. 
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Moss+Lichen %  

This field defines the percentage of lichen and moss biomass consumed in the broadcast burn.  Moss 

and lichen biomass are used in the Fire Behavior Fuel Model selector, and the consumed amounts are 

included in the total emissions.  Consumption of these fuels in FuelCalc is calculated by multiplying the 

value in this field times the pre-treatment lichen and moss biomass.   

Moisture  

FuelCalc allows you to specify a fuel moisture scenario (Table 11-3), which sets fuel moisture for the 

different fuel components.  Selecting a fuel moisture scenario from the drop-down menu will offer some 

default moisture settings, but the values can be edited.  Changing the fuel moisture value will modify 

fuel consumption and emission outputs.   

Table 11-3: Fuel Moisture regimes and percent moisture for down woody material 
and duff. 

Regime 

 
Regime 

10-hr 
 

10-hr 

1000-hr 
 

1000-hr 

Duff 
 

Duff 
Very dry 6 10 20 

Dry 10 15 40 

Moderate 16 30 75 

Wet 22 40 130 

Region  

FuelCalc uses an algorithm decision key from FOFEM that selects the best available algorithm for 

predicting fire effects based on the conditions specified.  “Region” is one of the variables used within 

this key for selecting shrub and duff consumption algorithms.  The available regions in FuelCalc are 

Interior West, Pacific West, Southeast, and Northeast. 

Season 

FuelCalc uses the variable “Season” in the FOFEM algorithm decision key to select herbaceous and shrub 

consumption algorithms.  The available seasons in FuelCalc are Spring, Summer, Fall, and Winter. 

Calculate button 

Clicking this button causes a treatment simulation to occur (Fig.11-7).  In some cases, a treatment 

simulation is run automatically (for example, using the Retention Priority Set selector) when you select 

or change certain inputs, but it is always best to click this button to ensure that the simulation actually 

takes place.  To reset the plot to pre-treatment conditions, uncheck the boxes next to each treatment 

and click Calculate.  

 
 Figure 11-7:  Treatment area of FuelCalc with the Calculate button circled. 
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Note: Below the 1000-Hr Rotten Classes, there is a place to adjust the number of decimal places 

that are shown in various output text boxes.  Setting this value to 3 may show trace amounts 

that otherwise would be shown as zeros due to rounding (Fig. 11-8).   

 

 
 

 

 

 

Figure 11-8:  Decimal place selector. 
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Fire Behavior Fuel Model Selector 

Surface fuel characteristics are fundamental inputs to the Rothermel (1972) surface fire spread model 

used in fire behavior modeling systems (Fig. 12-1).  FuelCalc contains an algorithm for selecting a 

standard fire behavior fuel model based on the modeled surface fuel characteristics present before and 

after treatment. The Fire Behavior Fuel Model Selector may be used for making fire behavior 

calculations in future versions of FuelCalc. In this version, it will simply let you see how the treatment (s) 

you’ve applied change the predicted fire behavior fuel model.  Note: the results provided by this 

preliminary version of the Fire Behavior Fuel Model Selector have not been verified. 

 
 

 

Appendix B contains details on the process used in FuelCalc to select a standard fire behavior fuel model 

from measured or calculated fuel characteristics. 

Note: The Fire Behavior Fuel Model Selector box can be hidden using Main Menu > Options > 

Show Fuel Model (Fig. 12-2).   

 
 

 

 

 

Figure 12-1: Fire Behavior Fuel Model Selector. 

Figure 12-2: From the Options menu you 

can de-select the Show Fuel Model feature. 
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Fire Behavior Fuel Model 

Using the plot fuel inputs, FuelCalc keys the input surface fuel load characteristics on your plot into a fire 

behavior fuel model (FBFM; Appendix B).  You can set FuelCalc to use the original 13 fuel models (Albini 

1976; Anderson 1982), the 40 fuel models (Scott and Burgan 2005), or all of the fuel models, in which 

case the most appropriate fuel model will be selected from the Albini and Scott and Burgan models 

combined.  Clicking Calculate will then activate the change, which will appear in the Pre-treatment and 

Post-treatment model boxes.  

Climate Type 

Select whether your plot is in an arid or humid climate.  This is required for determining the most 

appropriate FBFM.   

SAV - Surface Area to Volume Ratio  

Surface area to volume ratio (SAV) is a function of piece diameter and is an important variable in fire 

behavior calculations. Surface area to volume ratio is the surface area of fuel particles per unit volume 

(Scott and Reinhardt 2007) and, for fuels that are long in relation to their thickness, is calculated with 

the formula: 

SAV =   
d

4
where, 

d is the diameter, in meters 

 

A characteristic of SAV ratio is that it decreases as particle volume increases. For more information on 

SAV ratio and its effect on fire behavior modeling, refer to Rothermel (1972) and Burgan and Rothermel 

(1984). 

There are three fields for entering the surface area to volume ratios: Herb, Shrub, and 1-Hour fuels.  

FuelCalc provides default SAV ratio values of 8200, 1480, and 1480 for herb, shrub, and 1-hr fuels, 

respectively.  Unfortunately, SAV values are rarely calculated in the field and difficult to find in the 

literature, so some suggested values are listed in Table 12-1.  

Table 12-1: Suggested SAV values for use in the Fire Behavior Fuel Model Selector. 

 

  
 

Herb 
 

Shrub 
 

1-Hr 
 

Source 

FuelCalc default 8200 1480 1480 Burnup calibration files 

Grass and grass-dominated  1500 3500 Albini 1976 

Chapparral and shrubfields 1500 1750-2000 Albini 1976 

Timber litter 1500 2000-2500 Albini 1976 

Logging slash 1500 1500 Albini 1976 
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Graph  

Two graphing options are available that can be used to visualize the effects of treatments on the plot.  

Three graphs are generated to represent the fuel stand: they include fine and course fuel graphs, pie 

charts of the percent removed, and stand watch for stand measurements. A separate emissions graph 

can also be created if broadcast burn is selected as a treatment option.  The Graphs window can be left 

open while adjustment to the treatments are made and calculated.  This allows you to see the influence 

of the changes that you are making to the plot.  

Fuel Stand 

Fine and Coarse Fuel graphs 

These graphs show the amount of fine and coarse fuels on the plot in tons per acre (Fig. 13-1). For each 

fuel class, there are four bars displaying the loading of pre-treatment, post-thinning and pruning, post-

piling and post-burn fuels.  Pre-treatment is the loading before any treatment (including piling), post- 

thinning and pruning is the loading after those activities but before piling, post-piling is the loading of 

un-piled fuels spread across the site and post-burn is the what is left after all the treatments have been 

completed.  

 
 

 

Note: You can save and/or print these two tables by right-clicking on them.  Other tables and 

charts that you are interested in saving and printing will have to be saved as screen captures.   

 

Pie charts  

The pie charts graphically show the percentage of each category that has been removed or harvested 

(Fig. 13-2).  The value next to each pie chart indicates the actual percent change.  Looking at the 

example below, we see that, for most of the categories, approximately 80% was removed, which leaves 

about 20% remaining.  The change shown for canopy cover is relative to the initial amount.  A value of 

80% shown next to the canopy cover pie chart indicates there was an 80% reduction.  Thus, if there 

Figure 13-1:  Fine Fuels and Coarse Fuels graphs. 
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were 30% canopy cover pre-treatment, there would be approximately 6% canopy cover when reduced 

by 80%.   

 
 

  

Stand Watch 

This chart displays pre- and post-treatment values for the selected stand attribute (Fig. 13-3); the 

available stand attributes are canopy fuel load, canopy bulk density, tree density, and basal area.  The 

blue column represents pre-treatment conditions, and the orange column represents post-treatment 

conditions.  An additional feature of this graph is that it will display the post-treatment values for up to 

50 treatment scenarios (after which it will reset), allowing for the comparison of stand attributes 

between treatments.   To clear the graph back to a single comparison, click the Reset button.   

 

 
 

Figure 13-2:  Stand Measurements and Timber Volume pie charts.  

Figure 13-3:  Stand Watch graph on 

FuelCalc Graphs window. 



FuelCalc User’s Guide   

44 
 

Emissions 

Although predicting emissions is not the main focus of FuelCalc, this graph is included to give an idea of 

the amount of emissions released from a broadcast burn treatment (it does not include estimates for 

crown consumption or pile burning) (Fig. 13-4).  The table area below the graph displays emissions for  

both the flaming and smoldering phases of combustion, in pounds emitted per acre, for the following 

pollutants: PM 2.5, PM 10, CH 4, CO2, CO, NOX, and SO2.  FuelCalc uses the same default equations 

used in FOFEM 6.3 (Reinhardt and others 1997) to calculate emissions by simulating the proportion of 

flaming and smoldering combustion.  Emissions production estimates combustion efficiency and 

emission factors, which vary with fuels and moisture.  Combustion efficiency is the proportion of carbon 

that is released as CO2 during burning (Reinhardt and others 1997); Emissions factors are calculated 

from combustion efficiency (Ward and others 1993). 

To display an emissions graph of a specific combustion component, click the box next to the component.  

Using the graph properties shown in Figure 13-4, you can adjust the way that the emissions data are 

displayed.  You can adjust the extent of the graph by adding smaller or larger values to the X and Y axis.  

For example, if the graph originally has 10 as the highest value on the Y axis, you can zoom into the 

graph by checking the Fixed Axis box and entering a lower value for the X and/or Y coordinate(s).  You 

can also rotate the graph to see different values from a different angle.  Right-click the graph to see 

options for printing and saving the graph.  

 
 

 

 

 

 

 

Figure 13-4:  Emissions graph. 
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Options 

The options menu is where the FuelCalc settings can be adjusted, the plot summaries can be created 

and displayed, the equations table can be displayed, and the display of the FuelCalc can be adjusted.   

The Settings option allows the user to create and save different treatments and to specify the desired 

retention priority (RP) for the plot.  Plot summaries can then be created as a way to store, transfer, and 

display the results of the FuelCalc calculations. The equations table displays the fuel component biomass 

scientific reference for the tree species that are recognized by FuelCalc.  The Color Setting and Show Fuel 

Model checkboxes are used to adjust the display of the main FuelCalc window. 

Settings 

Treatments 

The treatments table (Fig. 14-1) displays all treatment scenarios that you have named and saved in the 

main FuelCalc window or entered in this window.  By saving the treatment that you applied, you can 

then go back and make adjustments until you have reached your desired plot conditions.  You can also 

track the different treatments that you have performed.  The treatments table allows you to edit 

previously saved treatments as well as create new treatments.  By naming any new treatment created 

and clicking Apply, the new treatment names will be made available in the Treatment Name drop-down 

menu in the main FuelCalc window  

Note:  The data grid row with the asterisk at the left (Fig. 14-1) indicates the empty row that will 

always be present.  If the empty row is edited, a new row will be added.  A pencil will appear on 

the row that is being edited.  To delete a data grid row, select the row by clicking the gray area 

to the left of the row and hitting the Delete key. 

 

 
 

 

Retention Priorities 

When choosing which trees to select for retention or removal before a thinning operation, a forester 

considers a variety of factors, including tree species, size, health, and vigor.  We have attempted in 

FuelCalc to simulate that same approach to choosing which trees are retained and which are removed 

during a simulated thinning.  FuelCalc does this by calculating a Retention Priority for each tree listed in 

the Treelist.  Retention priority is calculated by multiplying together five individual retention priority 

Figure 14-1: Treatments table on the Settings window.  
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factors for each tree record: tree status, crown class, crown ratio, diameter, species/diameter . Each of 

these factors varies from 0 to 1, so the product of the five factors also varies from 0 to 1.  Trees with the 

lowest retention priorities are removed first, followed by trees with increasing retention priority.  Trees 

are removed in this order until the thinning target is met.   

Each retention priority factor has one or more user-definable settings, which allow the simulation of 

different types of thinning, such as low thinning or high (crown) thinning.  Default retention priority 

factor settings for three thinning types are included within FuelCalc; however, you can create and save 

custom settings.  

Values must be selected in the Retention Priorities table in order for the Species Priorities to take effect.   

The trees-per-acre value for a removed tree will be reduced by the specified Cutting Efficiency (see  

Cutting Efficiency % in the Thinning section) until the target thinning criteria value has been reached, 

subject to constraints on the minimum and maximum size of trees that may be removed.  

The following sections describe the different priority factors and how they are combined to an overall 

retention priority.  

Tree status retention priority factor 

The tree status factor is a scaling value that indicates the relative priority for retaining each of the four 

different tree status categories recognized in FuelCalc (See the Tree Status section for definitions of tree 

status):  

• Healthy (H) 

• Unhealthy (U) 

• Sick (S) 

• Dead (D) 

Tree status priority factors range from 0 to 1.  A value of 1 means that a tree is highly desired for 

retention; whereas, a value near 0 means the tree is highly desired for removal.  A tree record without a 

tree status value defaults to a retention priority factor value of 1.  Tree status retention priority factors 

for FuelCalc's default thinning types are shown below (Fig. 14-2). 

 

 
Figure 14-2:  Retention Priorities table with Tree Status highlighted. 
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Crown class retention priority factor 

The crown class factor indicates the relative priority to retain trees of different crown classes.  Crown 

class is a categorical variable specified for each tree record as part of the Treelist.  A thinning type may 

emphasize retention of certain crown classes over others.  These priority factors are used to specify 

which classes are emphasized for retention versus removal.  Crown class priority factors can range from 

0 to 1.  A value of 1 indicates a tree that is highly desired for retention; a value near 0 indicates that a 

tree is highly desired for removal.  Crown class retention priority factors for FuelCalc's default thinning 

types are shown below (Fig. 14-3). 

 

 

Crown ratio retention priority factor 

Each tree record in the Treelist has an implied crown ratio (CR), which is the ratio of the live crown 

length to total tree height (Fig. 14-4).  Crown length is the height of the tree (TH) minus the height to the 

base of the crown (CBH), so CR is calculated from the Treelist variables as follows: 

𝐶𝑅 =
𝑇𝐻 − 𝐶𝐵𝐻

𝑇𝐻
 

 

 

Trees with higher crown ratios are generally more vigorous and therefore are usually a higher priority 

for retention during a thinning.  However, beyond a certain CR value, increases in crown ratio do not 

necessarily indicate increased vigor, and therefore do not increase retention priority.  Two settings are 

Figure 14-3:  Retention Priorities table with Crown Class in the red box. 

Figure 14-4:  Retention Priorities table with Crown Ratio highlighted. 
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therefore used to specify the calculation of crown ratio retention priority factor: CRmax and CRspec.  

CRmax is the CR above which the crown ratio factor is 1.  All trees with CR greater than CRmax are 

assigned a crown ratio factor of 1 and are thus equally desired for retention.  CRspec is the user-defined 

crown ratio retention factor for a tree with CR = 0.1 (corresponding, roughly, to the lowest CR possible 

for a living tree).  The two settings are used to define a straight line (see Fig. 14-5 below).  Trees with CR 

between 0.1 and CR of maximum priority are assigned a crown ratio priority that is proportionally scaled 

between this user-controlled value and 1 (Fig. 14-5).  The result of the default values of CRmax and 

CRspec for both low and high thinning is shown in the figure below. 

 

 

 

 

 

The calculation used in FuelCalc to calculate the crown ratio retention priority factor (CRfactor) is as 

follows: 

𝐶𝑅𝑓𝑎𝑐𝑡𝑜𝑟 = 𝑀𝐼𝑁(1, (
1 − 𝐶𝑅𝑠𝑝𝑒𝑐

𝐶𝑅𝑚𝑎𝑥 − 0.1
) (𝐶𝑅 − 𝐶𝑅𝑚𝑎𝑥) + 1) 

To eliminate crown ratio as a factor affecting retention priority, set CRspec to 1.  Setting CRspec to 1 will 

result in a crown ratio retention priority factor of 1.0 for all trees. 

Crown class retention priority factor inputs for FuelCalc's default thinning types are shown above in 

Figure 14-4. 
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Figure 14-5:  Crown Ratio Factor graph.  CRmax is the point on this graph where the 

crown ratio RP factor = 1.0 (in this case around CR 0.5). CRspec is the user-defined 

value for crown ratio RP factor for a CR of 0.1.  In this case, it is 0.5. A straight line 

connects CRspec and CRmax. 
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Diameter retention priority factor 

Tree diameter at breast height (DBH) is a common factor affecting the desirability of a tree for retention 

after thinning (Fig. 14-6).  In FuelCalc, DBH is used to compute a diameter retention priority factor for 

each tree in the Treelist.  The first step is computing each tree’s relative DBH (DBHrelative), which is 

calculated as the DBH of the tree divided by the maximum DBH of all trees in the Treelist (MaxDBH).  

𝐷𝐵𝐻𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 = (
𝐷𝐵𝐻

𝑀𝑎𝑥𝐷𝐵𝐻
) 

The result is a fraction between 0 and 1 (a value of 0 is possible only for a DBH = 0 cm).  The next step is 

to calculate the diameter retention priority factor.  The retention priority factor will always equal 1.0 for 

the largest tree (DBHrelative = 1), but a second input is needed to calculate the retention priority factor 

for smaller diameter trees.  That input is the retention priority factor to use for the smallest tree 

(MinDBHfactor).  The final diameter factor is calculated as shown below: 

𝐷𝐵𝐻𝑓𝑎𝑐𝑡𝑜𝑟 = (1 −𝑀𝑖𝑛𝐷𝐵𝐻𝑓𝑎𝑐𝑡𝑜𝑟) ∗ (
𝐷𝐵𝐻

𝑀𝑎𝑥𝐷𝐵𝐻
) +𝑀𝑖𝑛𝐷𝐵𝐻𝑓𝑎𝑐𝑡𝑜𝑟 

 

 

 

The result of the calculation of DBH retention priority factor is shown in below Figure 14-7 for a value of 

MinDBHpriority = 0.5.  In the chart, the X-axis is DBHrelative (the ratio of the subject tree’s DBH to the 

maximum DBH on the plot); the Y-axis is the calculated diameter retention priority factor. This 

calculation of a diameter retention priority factor means that a tree of half the maximum diameter will 

be given a diameter factor half-way between 1.0 and the specified MinDBHPriority. To eliminate 

diameter as a factor affecting retention priority set Diameter to 1. 

 

Figure 14-6:  Retention Priorities table with Diameter in the red rectangle. The value in the Diameter field 

is the retention priority of a tree where DBH=0 inches (MinDBHfactor). 



FuelCalc User’s Guide   

50 
 

 

 

 

Crown Ratio Help 

Clicking this button provides a brief description of CRspec, CRmax and Diameter 

 

Settings Report 

Clicking this button provides a text report of the Treatments, Retention Priorities and Species Groups 

used in the currently selected project. 

 

Apply 

Clicking the apply buttons makes the modifications and additions to the Treatments and 

Retention Priorities available in the main interface.  

 

Species Group 

The Species Group window is available by clicking the Species Group button at the lower right of the 

Settings window. Click the File menu on the Species Group window to see the options for creating, 

saving and deleting species groups. The currently active species group is displayed in the dropdown 

field.  

 

Tree species is the final factor affecting overall retention priority (Fig. 14-8).  Species factors can be set 

separately for ranges of DBH values to allow for more flexibility in tree selection. Retention priority can 

be set from 0.0 and 1.0. Trees with low retention priority are removed first. There are also two special 

codes. Trees with retention priority of 0.0 will always be removed and trees with retention priority of 99 

will always be retained.  In the Species Group window, you can either select a value for all trees of a 

specific species regardless of size, or you can select one species and make several different size 
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Figure 14-7:  Diameter Factor graph showing the rate at which diameter factor rises as 

DBH/maxDBH increases. 
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distinctions to remove trees of one size over another.  For example, Figure 14-8 below illustrates species 

factors for three diameter ranges of Douglas-fir (PSME).  The priority factor is set to 0 for trees less than 

4 inches DBH, meaning that these trees will be the highest priority for removal.  Trees between 4 and 16 

inches DBH have a species priority factor of 0.7.  Finally, Douglas-fir trees greater than or equal to 16 

inches DBH are set to always be retained, even if that means the thinning target cannot be met. 

 

NOTE: A good practice is to include a row for _Other species not specifically listed in the 

Species Group. 

  
 

 

FuelCalc will apply the Species Group retention factors when the group is selected in the Species Group 

column of the Retention Priorities table. The overall retention priority for each tree is simply the product 

of the above factors (tree status, crown class, crown ratio, diameter, and species). The species priority 

factor code of 99 (always retain) supersedes a zero value for any of the other factors, so no trees of a 

given species and diameter range will be harvested if they are given a code of 99, regardless of other 

settings. If you want FuelCalc to use only the retention values in the Species Priority window set all cells 

in the new row of the Retention Priorities table to 1. 

 The File dropdown has options for the Species Groups: New Group, Save Group, Save Group As, Delete 

Group. 

   

 

Option Description 

New Group Creates a new group with one record for _Other 
species 0 to 100 dbh. 

Save Group Saves the selected Species Group 

Save Group As Duplicates the selected Species Group that can be 
renamed. 

Delete group Deleted the selected Species Group. 

Figure 14-8:  Species Group table with values set. 

Figure 14.9: Species 
Group, File menu options 

Table 14.1: Species Group, File menu option descriptions. 
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Run Batch Summary 

You can automatically run all plots in the current project through FuelCalc using the treatment options 

you have set on the interface. The Plot Input File, Tree Input File, Output File, and Error File fields will be 

automatically filled out (Fig. 14-10). Click Run to begin processing. Use Pause and Continue to stop and 

start the execution. Click Abort to stop execution. Click the Open Error File button to view execution 

errors. The error file will describe the action taken. Records with errors are removed from the 

calculations. Records with substitutions are not removed from the calculations. 

 

                                      Figure 14-10: The Batch Summary screen 

Note: Click the Summary Report Update button at the lower right of the main FuelCalc screen 

when making subsequent batch summaries with modified simulation settings.  

 

Results are in a .csv file saved in your current working directory. Each row includes pre- and post-

treatment fuel and stand conditions for a plot. Average values are reported in the last row of the 

spreadsheet. (Figure 14-11).  
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Show Plot Summary 

View the output of the last stand summary you ran (Figure 14-12). The table reports the same 

information as the plot summary .csv file but is available directly in FuelCalc. 

 

 

Equation Table 

The equation table simply displays valid species in FuelCalc and the associated canopy load and load 

distribution equations. Click on a species code in the table to see reference information at the bottom of 

the screen (Figure 14-13). Equation assignments cannot be modified in this table; however, there is an 

Figure 14-11:  The plot summary is saved to a .csv file. Each row includes pre- and post-treatment 

fuel and stand conditions for a plot. Average values are included in the last row.   

Figure 14-12:  The plot summary that was run can be viewed directly in FuelCalc.  
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option for editing them discussed in Appendix C.  See Appendix D for more information about how 

canopy loading is calculated. Click Close to close the table.  

 

 

Color Settings 

This option lets you modify some of the FuelCalc user interface color settings. 

Show Fuel Model 

This option is used to toggle the Fire Behavior Fuel Model Selector section of the user interface on and 

off. 

Treatment File 

This option is used for creating the Treatment file used by the command line version of FuelCalc. The 

Treatment file can be created manually but this window (Fig. 14-14) makes it easier to set up the file. 

Create - Brings all plots in the Project File into the grid. 

Save - Saves the settings in CSV format that can be used by the command line batch program. 

Import - Import and existing Treatment file.  

Refresh - Updates the Thin, Prune, Pile and Burn checkboxes for all plots based on the user 

interface for those fields. 

 

Figure 14-13. The equations used for calculating canopy fuel loading and 

distribution are displayed in the equations table. 
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Figure 14-14. Example treatment file creator window. 

Set the Retention Priority and Treatment dropdowns and the Thin, Prune, Pile and Burn checkboxes as 

desired. The Retention Priorities and Treatments are created on the Settings window. The Project File 

includes the Thin, Prune, Pile and Burn settings. 
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Appendix A:  Field Name and Description for .FFI and .TRE Files 
Produced by FFI 

Files exported from FFI can be imported into FuelCalc. There will be two files (required), one with the 

fuels information (with a FFI extension) and one with the tree information (with a TRE extension). These 

files may also be manually created. Example files are included with the FuelCalc installer.  

 

 

.FFI 

Field name Description 

PlotId FFI Macro plot identifier 

Monitoring Status FFI Monitoring status name 

Monitoring Status Order FFI Monitoring status order number (numbered sequentially when 
there are multiple monitoring statuses for one plot) 

TotalDuffLoad1 Duff load (t ac-1). From Surface Fuels protocol and/or the Biomass-
Fuels  protocol 

DuffDepth Duff Depth (in.). From Surface Fuels protocol and/or Biomass-
Fuels protocol.  

LitterLoad1 Litter load (t ac-1). From Surface Fuels protocol and/or the 
Biomass-Fuels protocol. 

LichenLoad1 Lichen load (t ac-1). From Surface Fuels – Alaska protocol and/or 
the Biomass-Fuels protocol. 

LiveMossLoad1 Live moss load (t ac-1). From Surface Fuels – Alaska protocol 
and/or the Biomass-Fuels  protocol 

DeadMossLoad1 Dead moss (t ac-1). From Surface Fuels – Alaska protocol and/or 
the Biomass-Fuels protocol. 

OneHour1 1-hr (0 - <0.25 in) woody load (t ac-1). From Surface Fuels protocol 
and/or the Biomass-Fuels  protocol and/or Photoload protocol 

TenHour1 10-hr (0.25 - <1.0 in) woody load (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol and/or Photoload 
protocol. 

HundredHour1 100-hr (1.0 - <3.0 in) woody load (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol and/or Photoload 
protocol. 

ThousandHourDc1Sz11 Load of 3 - < 6 in. decay class 1 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class3 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc1Sz21 Load of 6 - < 9 in. decay class 1 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class4 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc1Sz31 Load of 9 - < 12 in. decay class 1 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >9” -20” class5 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc1Sz41 Load of 12 - < 20 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass-Fuels protocol >9” -20” class6 
and/or Logs-Fixed Area protocol. 

ThousandHourDc1Sz51 Load of >= 20 in. decay class 1 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >20” class and/or Logs-
Fixed Area protocol. 

Table A-1:  .FFI file field names and descriptions. 
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ThousandHourDc2Sz11 Load of 3 - < 6 in. decay class 2 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class3 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc2Sz21 Load of 6 - < 9 in. decay class 2 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class4 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc2Sz31 Load of 9 - < 12 in. decay class 2 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >9” -20” class5 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc2Sz41 Load of 12 - < 20 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass-Fuels protocol >9” -20” class6 
and/or Logs-Fixed Area protocol. 

ThousandHourDc2Sz51 Load of >= 20 in. decay class 2 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >20” class and/or Logs-
Fixed Area protocol. 

ThousandHourDc3Sz11 Load of 3 - < 6 in. decay class 3 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class3 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc3Sz21 Load of 6 - < 9 in. decay class 3 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class4 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc3Sz3v Load of 9 - < 12 in. decay class 3 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >9” -20” class5 and/or 
Logs-Fixed Area protocol and/or Logs-Fixed Area protocol. 

ThousandHourDc3Sz41 Load of 12 - < 20 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass-Fuels protocol >9” -20” class6 
and/or Logs-Fixed Area protocol. 

ThousandHourDc3Sz51 Load of >= 20 in. decay class 3 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >20” class and/or Logs-
Fixed Area protocol. 

ThousandHourDc4Sz11 Load of 3 - < 6 in. decay class 4 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class3 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc4Sz21 Load of 6 - < 9 in. decay class 4 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class4 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc4Sz31 Load of 9 - < 12 in. decay class 4 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >9” -20” class5 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc4Sz41 Load of 12 - < 20 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass-Fuels protocol >9” -20” class6 
and/or Logs-Fixed Area protocol. 

ThousandHourDc4Sz51 Load of >= 20 in. decay class 4 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >20” class and/or Logs-
Fixed Area protocol. 

ThousandHourDc5Sz11 Load of 3 - < 6 in. decay class 5 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class3 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc5Sz21 Load of 6 - < 9 in. decay class 5 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >3” -9” class4 and/or 
Logs-Fixed Area protocol. 

ThousandHourDc5Sz31 Load of 9 - < 12 in. decay class 5 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >9” -20” class5 and/or 
Logs-Fixed Area protocol. 
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ThousandHourDc5Sz41 Load of 12 - < 20 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass-Fuels protocol >9” -20” class6. 

ThousandHourDc5Sz51 Load of >= 20 in. decay class 5 fuels (t ac-1). From Surface Fuels 
protocol and/or the Biomass-Fuels protocol >20” class and/or Logs-
Fixed Area protocol. 

HerbLoadDead Dead herb load (t ac-1). From Surface Fuels-Vegetation protocol  

HerbLoadLive1 Live herb load (t ac-1). From Surface Fuels-Vegetation protocol 
and/or the Biomass-Fuels protocol and/or Photoload protocol. 

ShrubLoadDead Dead shrub load (t ac-1). From Surface Fuels-Vegetation protocol  

ShrubLoadLive1 Live shrub load (t ac-1). From Surface Fuels-Vegetation protocol 
and/or the Biomass-Fuels protocol and/or Photoload protocol. 

ShrubLiveSAV2 Not exported from FFI 

HerbSAV2 Not exported from FFI 

WoodySAVOneHour2 Not exported from FFI 

FractionGroundAreaPile
Covered2 

Proportion of Sample Area covered by pile(s). From Surface Fuels-
Piles protocol. 

PileLoadWholePlot1 Load of piled fuels (t ac-1). From Surface Fuels-Piles and/or 
Biomass Fuels protocol. 

EmisSTSF2 Not exported from FFI 

EmisDuffRSC2 Not exported from FFI 

EmisCWDRSC2 Not exported from FFI 
1 If loading data for the same component exists in more than one protocol, the average of the values will be 
used in FuelCalc. 

2 If you enter data in these fields in the .FFI file, FuelCalc will use the data.  
3 FuelCalc 3”–6” class loading = Biomass-Fuels >3”-9”*0.265 
4 FuelCalc 6”–9” class loading = Biomass-Fuels >3”-9”*0.735 
5 FuelCalc 9”–12” class loading = Biomass-Fuels >9”-20”*0.301 
6 FuelCalc 12”–20” class loading = Biomass-Fuels >9”-20”*0.699 

 

 

 

.TRE 
 
Field name 

 
Description 

PlotId Macro plot identifier  

TreeSpecies Tree species code (NRCS Code required) 

TreeExpansionFactor Representative tree density (trees ac-1) 

Diameter1 Tree DBH (in.) 

TreeHeight Tree height (ft) 

CrownBaseHeight2 Live crown base height (ft) 

TreeStatus3 Tree status (L, H, U, S, D) 

CrownClass4 Crown class (D, C, I, S, N) 

Crown Ratio5 Crown ratio (0 – 100) (ideally, uncompressed crown ratio) 

BoleCharHeight Bole char height (ft) 

CrownScorch%6 Crown scorch (%) 

ScorchHeight Scorch height (ft) 

CKR Cambium kill rating (0-4) 

BeetleDamage7 Beetle damage (Y, N) 

EquationType8 Equation type (CRNSCH, CRCABE, BOLCHR) 

FlHt/ScHt Flame height/scorch height (ft) 

Table A-2:  TRE file field names and descriptions. Files exported from FFI will include tree 

data from the Trees-Individuals method and, based on selections set in FFI, may include 

Saplings and Seedlings records. The first row of the file must include the label “PlotID”. 
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FS 
Describes the value in the FlHt/ScHt field. Flame height (F) 
or scorch height (S). 

Severity Fire severity (L or blank) 

1 If values are entered in both the DBH and DRC fields in FFI then DBH will be exported. If the DBH 
field is null and DRC has a value then DBH=(DRC-2.2)/1.3. For trees <4.5’ tall, DBH=0.1. DBH is 
converted back to DRC for NRCS codes linked to 2-letter FuelCalc codes in the sample-species.csv 
file. 

2 This field is populated with values in the Live Crown Base Height or Crown Fuel Base Height field in 
the FFI Trees-Individual protocol. If crown height is missing then FuelCalc calculates Crown Base 
Height using height and crown ratio. For the Sapling and Seedling protocols, FuelCalc calculates 
Crown Base Height using the FFI Crown Ratio and height fields. Live Crown Base = 50% of height if 
other information is missing. Leave blank for dead trees.  

3 Tree status code of I (Injured) in FFI will be assigned the code S (Sick) in FuelCalc. Tree status code 
X (Not Assessed) in FFI will be assigned the code D (Dead) in FuelCalc. Tree status code L in FFI will 
be assigned code H in FuelCalc.  

4 Crown class code of SC (Subcanopy) in FFI will be assigned I (Intermediate) in FuelCalc. Class code 
of O (Open grown) in FFI will be assigned C (Codominant) in FuelCalc. Class code of E (Emergent) in 
FFI will be assigned D (Dominant) in FuelCalc. Class code of X (Not assessed) in FFI will be assigned 
N (None). Crown Class codes that are blank in the .TRE file (e.g., seedlings, saplings and snags) will 
be assigned N (None) in the FuelCalc user interface. 

5 If Crown Base Height is missing then Crown Base Height = Tree Height – (Tree Height * (Crown 
Ratio/100)).  

6 In the CRCABE equations, this value is set to equal either Crown Length Scorched, Crown Scorch 
or Crown Kill based on the species and mortality equation.  

7 If the Trees – Individuals, Damage Code 1, 2 or 3 fields equal 10000 or “INSE”, then this field will 
be set to “Yes”; otherwise, it will be blank. 

8 This value is set based on data in the Trees-Individuals protocol 
  If the CKR field is not null then “Equation Type” is set to “CRCABE”  

If the Char Height field is not null then “Equation Type” is set to “BOLCHR”   
Otherwise “Equation Type” is set to “CRNSCH” 
 

Appendix B:  Selecting the Fire Behavior Fuel Model 

 

Selecting a standard fuel model from fuel load data is a two-step process.  The first step is narrowing the 

range of fuel model choices to a reasonable number based on fire-carrying fuel type, climate type 

(which relates to extinction moisture content), and which set of standard fire behavior fuel models to 

choose from.  Step two is selecting from the narrowed list based on a similarity index of fuelbed 

characteristics, such as fine fuel load, characteristic surface area to volume ratio, packing ratio, and bulk 

density.  These characteristics can be calculated for both the measured/modeled fuel loads and for the 

standard fuel models. 

Narrowing the fuel model choices 
For any given fuelbed, three pieces of information are used to narrow the list of fuel model choices: 

major fire-carrying fuel type, climate type, and fuel model set.  A set of rules is used to classify the 

fuelbed into a major fire-carrying fuel type.  Climate type and fuel model set are direct inputs. 
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Fire-carrying fuel type 

The FuelCalc method recognizes four of the six fire-carrying fuel types described in Scott and Burgan 

(2005): grass (GR), grass-shrub (GS), shrub or timber-understory (SH/TU), and timber litter or 

slash/blowdown (TL/SB).  The TL and SB fuel types are combined because both consist entirely of dead 

fuel.  SH and TU fuel types are combined because both consist of a large fraction of dead fuel with a 

component of live woody or herbaceous fuel (or both).  A simple key is used to classify any fuelbed into 

one of these fuel types.  To use the key, three fuelbed characteristics must first be calculated:  

LiveFraction is the ratio of live fuel load (grass/herbaceous load plus fine live shrub load) to the total fine 

fuel load (which is the live fuel load plus the 1-hr timelag class dead fuel load).  LiveFraction is used to 

determine if the fuelbed should be treated as a dead-fuel-only fuel model or as a fuel model that 

contains live fuel.  LiveFraction theoretically varies between 0.0 (for fuelbeds with no live fuel) and 1.0 

(for fuelbeds with only live fuel).  In practice, fuelbeds normally have some amount of dead fuel, so the 

LiveFraction normally approaches 1.0 without reaching it. 

HerbFraction is the ratio of the herbaceous load to the total fine fuel load.  HerbFraction is used to 

determine if a fuelbed that has previously been determined to have a live fuel component is a grass-

dominated fuelbed.  Like LiveFraction, HerbFraction theoretically varies between 0.0 (for fuelbeds with 

no herbaceous fuel) and 1.0 (for fuelbeds with only herbaceous fuel).  In practice, even pure-grass 

fuelbeds normally have some amount of dead fuel (grass litter, for example), so the HerbFraction 

normally approaches 1.0 without reaching it.  A grass-dominated fuelbed will have a high HerbFraction. 

HerbRatio is the ratio of the herbaceous load to the fine live woody load, which varies between 0.0 and 

1.0 for all fuelbeds.  If the fuelbed has no live woody load, this ratio should be set to 1.0.   

Once the above quantities have been computed, the following selection key identifies the fire-carrying 

fuel type.  (In the unlikely event that a fuelbed contains no fine fuel load—just 10- and 100-hr timelag 

class dead particles—then the fuel type is set to TL/SB.) 

A. IF LiveFraction ≤ 0.20 THEN the live fraction is inconsequential and a fuel model that does 
not include any live fuel will be selected (FuelType = TL/SB). 

B. IF LiveFraction >  0.20 THEN the live fraction is significant and a fuel model that contains a 
live herbaceous or live woody component will be selected (continue with a. below). 

a. IF HerbFraction ≥ 0.75 THEN the fuelbed is dominated by herbaceous fuel and a grass-
dominated fuel model will be available for selection (FuelType = GR). 

b. IF HerbFraction < 0.75 THEN the fuelbed is not dominated by grass/herbaceous fuel 
(continue with i. below). 
i. IF HerbRatio > 2.0 THEN grass/herbaceous component is dominant and fuel type is 

GR. 
ii. IF HerbRatio > 0.25 but <= 2.0 THEN both the grass/herbaceous load is enough to 

require a GS fuel model, but not enough to indicate a GR model, as above (FuelType 
= GS). 

iii. IF HerbRatio ≤ 0.25 THEN the grass component is not enough to indicate a GS fuel 
model, and any SH or TU fuel model may be appropriate (FuelType=SH/TU). 
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Climate type  

Fuel models appropriate for humid and sub-humid climates have higher extinction moisture contents 

than fuel models for arid and semi-arid climates.  Therefore, a different subset of fuel models is 

available for selection in the different climate types (with some overlap).  Two climate types are 

available: 

• Arid to semi-arid climates (low extinction moisture content) 

• Humid to sub-humid climates (high extinction moisture content) 

 
Fuel model set 

The last piece of information needed is which set of standard fire behavior fuel model to use.  Two 

complete sets are available: the original 13 fuel models (Albini 1976; Anderson 1982) and the 40 fuel 

models (Scott and Burgan 2005) (Table C-1).  Although those sets were designed to stand alone, some 

people prefer to draw from among all 53 fuel models.  FuelCalc allows three choices for fuel model set: 

• Original 13 

• 40 fuel models 

• All 53 fuel models 

 
The table below identifies the standard fuel models appropriate for each of the four fire-carrying fuel 

types, for both arid climates and for humid climates. 

 

 

  
Arid climate fuel models Humid climate fuel models 

  GR GS SH/TU TL/SB GR GS SH/TU TL/SB 

O
ri

g
in

a
l 
1

3
 f

u
e
l 
m

o
d

e
ls

 

1 X X   X X   
2 X X X  X X X  
3 X X   X X   
4   X    X  
5  X X    X  
6         
7   X   X X  
8    X    X 

9    X    X 

10   X    X  
11    X    X 

12    X    X 

13    X    X 

N
e
w

 4
0
 f

u
e

l 
m

o
d

e
ls

 

GR1 X    X    
GR2 X X       
GR3     X X   
GR4 X X       
GR5     X X   
GR6     X X   
GR7 X        
GR8     X    
GR9     X    
GS1  X       
GS2  X       

Table C-1: The standard fuel models appropriate for each of the four fuel 

types for both arid climates and for humid climates.  

  



FuelCalc User’s Guide   

64 
 

GS3      X   
GS4      X   
SH1  X X   X   
SH2  X X      
SH3      X X  
SH4      X X  
SH5   X      
SH6       X  
SH7   X      
SH8       X  
SH9       X  
TU1   X    X  
TU2       X  
TU3       X  
TU4   X      
TU5   X      
TL1    X    X 

TL2    X    X 

TL3    X    X 

TL4    X    X 

TL5    X    X 

TL6    X    X 

TL7    X    X 

TL8    X    X 

TL9    X    X 

SB1    X    X 

SB2    X    X 

SB3    X    X 

SB4    X    X 

 

 

For example, appropriate fuel models for a grass-dominated fuelbed (GR) in arid climates include fuel 

models 1, 2, and 3 from the original 13; and GR1, GR2, GR4, and GR7 from the 40 fuel model set.  For a 

grass fuel type in a humid climate, the same original 13 fuel models are available (1, 2, and 3), but the 

narrowed list from the set of 40 fuel models includes GR1, GR3, GR5, GR6, GR8, and GR9.   

Depending on your preference, the final narrowed list could include fuel models from 1) only the 13 

original fuel models, 2) only the set of 40 fuel models, or 3) both sets of fuel models. 

Selecting a fuel model from the narrowed list 

Once the list of potential fuel models has been narrowed from step 1, the next step is to compute a 

departure index comparing characteristics of the subject fuelbed to characteristics of each of the fuel 

models on the narrowed list. The departure of the fuelbed from each candidate fuel model is then used 

to select best one or two fuel models. 

Fuelbed depth 

Fuelbed depth is the fuel model parameter, but in reality the fire model is using that depth to compute 

bulk density and packing ratio; fuelbed depth itself if not a direct input to the Rothermel spread model. 

Spread rate and intensity is very sensitive to bulk density and packing ratio. In recognition of this, the 
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procedure used to estimate fuelbed depth is really designed to estimate a reasonable bulk density—

fuelbed depth is computed from that estimate. 

Three intermediate quantities are needed in order to compute fuelbed depth for this custom fuel 

model: total fuel load (TFL), fine dead fuel load (FDFL) and fine fuel load (FFL). Total fuel load is the sum 

of litter, 1-h, 10-h, 100-h, live herbaceous and live woody load; fine dead fuel load is just litter+1-h load; 

and fine fuel load is the sum of the litter+1-h load, herbaceous load, and live woody load parameters.  

The fuelbed depth and bulk density are directly related: 

𝐹𝑢𝑒𝑙𝐵𝑒𝑑𝐷𝑒𝑝𝑡ℎ =
𝑇𝐹𝐿

𝐵𝐷
∗ 0.04591 

where TFL is the total fuel load (t/ac) and BD is fuelbed bulk density (lb/ft3). The factor 0.04591 is a unit 

conversion factor.  

Bulk density is the weighted-average of live and dead fuel bulk density values: 

𝐵𝐷 = 𝐵𝐷𝑙𝑖𝑣𝑒 + [𝑊𝐹 ∗ (𝐵𝐷𝑑𝑒𝑎𝑑 −𝐵𝐷𝑙𝑖𝑣𝑒)] 

where BDlive is the bulk density of the live fuel component of the fuelbed, BDdead is the bulk density of the 

dead fuel component, and WF is a weighting factor that scales between BDlive and BDdead. BDlive and 

BDdead are user-specified constants for each simulation. Default BDlive is 0.10 lb/ft3; default BDdead is 0.75 

lb/ft3. The weighting factor (WF) is calculated as follows: 

𝑊𝐹 =
𝐹𝐷𝐹𝐿

𝐹𝐹𝐿
 

where FDFL and FFL are as defined above (t/ac). In other words, WF is the fraction of the fine fuel load 

that is dead. As used in the equation for BD, WF simply scales BD between the values for the live and 

dead fuel components. A fuelbed with no live fuel (WF = 1) will result in BD = BDdead. A fuelbed with no 

fine dead fuel (WF = 0) will return BD = BDlive. A fuelbed for which the fine dead fuel load equals the fine 

live fuel load (WF = 0.5) will return a BD that is halfway between the values for BDlive and BDdead. 

Departure index 

The departure index is the weighted average of the departure of three separate fuelbed characteristics: 

characteristic surface area to volume ratio (SAV), fuelbed bulk density (BD), and fine fuel load (FFL) Fine 

fuel load is the load of live and dead fuel less than 6 mm (0.25 in.) diameter. A normalized departure 

index is computed for each of those factors. The departure index (DI) is the square of the difference 

between the fuelbed characteristic and the fuel model characteristic, normalized by dividing by the 

standard deviation of the characteristic across all 53 standard fuel models. The final departure is a 

weighted average of the three characteristics. Bulk density and SAV are weighted equally (0.25 each); 

fine fuel load receives twice the weight of SAV and bulk density (0.50). The departure index is therefore 

defined as follows: 
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𝐷𝐼 = 0.25 ∗ (
𝑆𝐴𝑉𝑓𝑢𝑒𝑙𝑏𝑒𝑑 − 𝑆𝐴𝑉𝑓𝑚

405.2
)
2

+ 0.25 ∗ (
𝐵𝐷𝑓𝑢𝑒𝑙𝑏𝑒𝑑 − 𝐵𝐷𝑓𝑚

0.3992
)
2

+ 0.50 ∗ (
𝐹𝐹𝐿𝑓𝑢𝑒𝑙𝑏𝑒𝑑 − 𝐹𝐹𝐿𝑓𝑚

3.051
)
2

 

where  

SAVfuelbed is the SAV of the subject fuelbed (ft-1) 

SAVfm is the SAV of the subject standard fuel model  (ft-1) 

405.2 is the standard deviation of SAV of the 53 standard fuel models (ft-1) 

BDfuelbed is the bulk density of the subject fuelbed (lb/ft3) 

BDfm is the bulk density of the subject standard fuel model (lb/ft3) 

0.3992 is the standard deviation of the bulk density of the 53 standard fuel models (lb/ft3) 

FFLfuelbed is the fine fuel load of the subject fuelbed (t/a) 

FFLfm is the fine fuel load of the subject standard fuel model (t/a) 

3.051 is the standard deviation of the fine fuel load of the 53 standard fuel models (t/a) 

For each subject fuelbed, the departure index is computed for each of the candidate standard fuel 

models on the narrowed list from the step 1. 

Choosing a standard fuel model  

The single best standard fuel model for the subject fuelbed is the one with the lowest similarity index. 

An index value of 0.0 indicates that all three fuelbed characteristics of the subject fuelbed exactly match 

one of the standard fuel models. 

Appendix C:  Adding and Editing Tree Species in FuelCalc 

FuelCalc includes an internal table of all the species crown biomass equations used to calculate canopy 

fuels. However, users may want to modify the equations selected for a species or may want to add new 

species and assign existing FuelCalc equations to that species.  

To facilitate using updated information FuelCalc looks for a file named species.csv when it first opens 

and, if the file exists in the C:\Users\username\AppData\Local\FuelCalc folder, then FuelCalc will use 

the crown biomass equations in that file rather than equations stored internally in the code.  

 The instructions below describe the steps used to create a file with new crown biomass assignments 

and/or new species.  

1) On the FuelCalc interface click Options>Equation table. 

 

 



FuelCalc User’s Guide   

67 
 

2) At the lower left click Create sample species file.  

    

3) A file named sample-species.csv will be saved in: C:\Users\username\AppData\Local\FuelCalcx.x. 

Click OK. 

 

4) In Windows Explorer or My Computer navigate to the sample-species.csv file and double-click the 

filename to open in Excel. 

5) The easiest way to add a species is to copy the row of a similar species and paste in the new row at 

the bottom.  

6) Change the first three columns (Order Num, Species Code, and Common Name).  The new species 

can then be assigned equation codes that are available in FuelCalc (Figure C-1). Two-letter species 

equation codes are defined in Appendix D. 

 

  
Figure C-1: This example shows whitebark pine added in sample-species.csv by copying 
the limber pine record and renaming it. Now PIAB can be included in the FuelCalc canopy 
calculations and mortality simulations. 

Table C-1. Column definitions for the species.csv file. 

Title Definition 

Order Num Sequential number. 

Species Code NRCS species code. 

Common Name Common name. 

Conifer/Hard/PJ This field is no longer used  

Inc CBD Include tree record with this species code in canopy fuel 
calculations: Yes or No. 

Tot1 Two-letter species code for calculating total crown biomass. 

Fol1 Two-letter species code for calculating foliage crown biomass. 

Twg1 Two-letter species code for calculating small branch (0”>0.25” 
diameter) crown biomass. 
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1in1 Two-letter species code for calculating 1 in. branch crown biomass. 

3in1 Two-letter species code for calculating 3 in. branch crown biomass. 

3+1 Two-letter species code for calculating 3+ in. branch crown 
biomass. 

Vert Dist1 Two-letter species code for calculating vertical distribution of crown 
fuel. 

Crown Reduc1 Two-letter species code for calculating reduction in crown biomass 
based on crown class. 

Canopy Cover1 Equation number used to calculate the canopy cover. Don’t change. 

Bole Volume Equation number used to calculate bole volume. Don’t change. 

FOFEM-Mort 
Spe-Code 

NRCS species code used for calculating tree mortality. Valid codes 
are the species codes in fof_spp.csv. 

1 See Appendix D for more information 

By default, FuelCalc does not calculate CBD, CBH, or SH for hardwood trees because hardwood trees 

generally do not influence crown fire. By changing the entry in the CBD column from “No” to “Yes,” 

the species will be included in the CBD, CBH, and SH calculations, and considered part of the available 

canopy.  

NOTE: Many species (including hardwood trees) are assigned the FOFEM default mortality 

equation which is based on results from conifer mortality studies. See the Scientific Content 

section of the FOFEM User Guide for more information. 

9) When you have finished making changes, save the file as species.csv. 

10) Close and re-open FuelCalc.   

11) Select Options>Equation Table and confirm the changes made in species.csv by checking the 

Equation Reference Table.  

12) Remember to delete or change the name of species.csv if you want to go back to using the internal 

FuelCalc equations. 

 

Appendix D:  FuelCalc Calculation Notes 

FuelCalc Biomass Equations                          

This appendix contains six subsections describing the biomass equation used in FuelCalc and the logic 

for computing crown and canopy biomass: 

 

      1. Crown weight equations 

      2. Crown weight proportion equations (foliage and small branch) 

      3. Vertical distribution 

      4. Crown class adjustment factors 

      5. Calculating canopy bulk density 

      6. Newer equations 
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      7. Small tree equations 

8. Canopy cover 

 

The two character species identifiers (Id) that are shown in the equation lists are used internally in 

FuelCalc to identify equations. The species names (Name) are, for the most part, the names of the 

species for which the equations were originally developed. FuelCalc contains an internal species list that 

connects the species codes to equations using the Id. 

 

Concerning other issues related to canopy bulk density measurements, please refer to the following 

source:  Reinhardt, E.D., and Crookston, N.L., Technical Editors. The Fire and Fuels Extension to the Forest 

Vegetation Simulator. Rocky Mountain Research Station RMRS-GTR-116. 2003. 218 p. 

 

Crown Weight Equations 

 

Crown weight equations predict total canopy weight. Total canopy weight is made up of all size class 

fuels. Most of the canopy weight equations are based on the original research papers listed in the 

“Source” column below. 

 

Sources for additional crown equations are shown in the Newer Biomass Equation in FuelCalc. 

 

Id = Species equation identifier, as used by FuelCalc 

Name = Species common and scientific name 

Source = Research paper 

Code = Computer program source code that the equation was taken from 

Equation = Weight equation as used in program source code 

 

Id      Species Name Source Code Equation 
PP   Ponderosa Pine Brn-78 BK wt = exp(0.268 + 2.074 * log(Dia)) 
GF   Grand Fir  Brn-78 BK wt = exp(1.3094 + (1.6076 * log (Dia))) 
DF   Douglas Fir Brn-78 BK wt = exp(1.1368 + 1.5819 * log(Dia)                           
LP   Lodgepole Pine Brn-78 BK wt = exp(0.1224 + 1.8820 * log(Dia) 
WL   Western Larch Brn-78 BK wt = exp(0.4373+ 1.6786 * log(Dia) 
SF   Subalpine Fir Brn-78 BK wt = (7.345 + (1.255 * Dia * Dia)) 
ES   Engelmann Spruce Brn-78 BK wt = exp(1.0404 + 1.7096 * log(Dia) 
WB   Whitebark Pine Brn-78 BK wt = (0.8371 * Dia * Dia) 
AL   Subalpine Larch      Uses western Larch 
WP   West. White Pine Brn-78 BK wt = exp(0.7276 + 1.5497* log(dia)) 
WC   Western Redcedar Brn-78 BK wt = exp(0.8815 + 1.6389 * log(Dia)) 
WH   Western Hemlock Brn-78 BK wt = exp(0.7218 + 1.7502 * log(Dia)) 
PS   Southwest Ponderosa Pine    Uses ponderosa pine        
BM   Bigleaf Maple SL-83 SR wt = exp (-0.0582 + 2.1505 * log(Dia)) 
MA   Pacific Madrone SL-83 SR wt = exp (-0.7881 + 2.4839 * log(Dia)) 
SE   Sequoia    Uses western Redcedar 
TO   Tanoak  SL-83 SR wt = exp(-0.3169 + 2.2774 * log(Dia)) 
RA   Red Alder  SL-83 SR wt = exp (-1.3290 + 2.6232 * log(Dia)) 
MH   Mountain Hemlock Gh-79 SR wt = exp (-3.8169 + 1.9756 * log (Dia * 2.54)) + 
                                                exp (-5.2581 + 2.6045 * log (Dia * 2.54)) 
PY   Pinyon Pine Gr-92 LG See Pinyon Grier below 
JP   Oneseed Juniper Gr-92 LG See Juniper Grier below 
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Crown Weight Proportion Equations (Foliage & Small Branch) 

Proportion equations predict the percentages of foliage and small branch biomass contained in the total 

canopy weight. The combined weights of foliage and small branch makeup the available canopy fuel 

(ACF); in most cases, only fifty percent of small branch is included in the ACF. 

 

Sources for additional crown equations are shown in the Newer Biomass Equation in FuelCalc. 

 

Id  = FuelCalc two-letter species equation identifier 

Name  = Species common and scientific name 

Source = Research paper 

Code  = Computer program source code that the equation was taken from 

Equation = Equation as used in program source code 

pfol = Percent of foliage 

pb = Percent of small branch (0 -> 1/4 inch) 

Dia = Diameter (in.) 

 

Id  Species Name  Source Code   Equation 
 
PP Ponderosa Pine  Brn-78 BK pfol = 0.558 * exp(-0.0475 * Dia) 
    pb = 0.625 * exp(-0.0511 * Dia ) 
GF Grand Fir  Brn-78 BK pfol = 1.0 / (1.592 + 0.0529 * Dia) 

pb = 1.0 / (1.15 + 0.0416 * Dia) 
                                     If dia > 36, pfol = 0.286, pb = 0.378 
DF Douglas Fir  Brn-78 BK pfol = 0.484 * exp(-0.021 * Dia) 
                                     pb = 0.729 * exp(-0.0233 * Dia) 
LP Lodgepole Pine Brn-78 BK pfol = 0.493 – 0.0117 * Dia 
                                     pb = 0.777 – 0.0146 * Dia 
WL Western Larch Brn-78 BK pfol = 0.347 * exp(-0.0434 * Dia) 
                                     pb = 0.745 * exp(-0.0362 * Dia) 
SF Subalpine Fir Brn-78 BK pfol = 0.597 * exp(-0.0425 * Dia) 
                                     pb = 0.864 * exp(-0.0373 * Dia) 
ES Engelmann Spruce Brn-78 BK pfol = 0.578 * exp(-0.0325 * Dia) 
                                     pb = 0.852 * exp(-0.0281 * Dia) 
WB Whitebark Pine Brn-78 BK pfol = 0.512 * exp(-0.0374 * Dia) 
                                     pb = 0.864 * exp(-0.0585 * Dia) 
AL Subalpine Larch Brn-78 BK pfol = 0.512 * exp(-0.0374 * Dia) Uses whitebark pine  

pb = 0.745 * exp(-0.0362 * Dia)   Uses western larch 
WP Western White Pine Brn-78 BK pfol = 0.550 * exp(-0.0345 * Dia) 
                                      pb = 0.914 - 0.0978 * sqrt(Dia) 
WC Western Redcedar Brn-78 BK pfol = 0.6174 * exp(-0.02326 * Dia)                                  
     pb =  0.7562 * exp(-0.02411 * Dia) 
WH Western Hemlock Brn-78 BK pfol = 0.547 * exp(-0.0370 * Dia ) 
                                      pb =  0.835 * exp(-0.0380 * Dia ) 
QA Aspen  Brn-78 BK pfol = 0.512 * exp(-0.0374 * Dia) Uses whitebark pine 
                          pb = 0.745 * exp(-0.0362 * Dia)   Uses western larch 
PS  Southwest Ponderosa Pine  Uses ponderosa pine 
BM Bigleaf Maple SL-83 SR pfol = 1.0 / (4.6762 + 0.1091 * pow (Dia,2.0390))  
     pb =  1.0 / (3.3212 + 0.0777 * pow (Dia,2.0496)) 
MA Pacific Madrone SL-83 SR pfol = 1.0 / (1.6013 + 0.3591 * pow(Dia,1.3090)) 
                                     pb  = 1.0 / (1.0357 + 0.2263 * pow(Dia,1.3567)) 
SE Sequoia  Brn-78 SR pfol = 0.5474 * exp(-0.03697 * Dia) Uses western hemlock 

pb  = 0.8352 * exp(-0.03802 * Dia)  Uses western hemlock                                            
TO Tanoak  SL-83 SR pfol = 1.0 / (1.7936 + 0.5952 * pow (Dia,0.7239)) 

pb  = 1.0 / (0.9940 + 0.4229 * pow (Dia,0.6520))  
RA Red Alder  SL-83 SR pfol = 1.0 / (2.7638 + 0.2155 * pow (Dia,1.3364)) 

pb  = 1.0 / (1.286 + 0.1016 * pow (Dia,1.3525))  
MH Mountain Hemlock Brn-78 SR if (Dia <= 40.0) pfol = 0.5474 * exp (-0.03697 * Dia) 
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Uses western hemlock  pb  = 0.8352 * exp (-0.03802 * Dia)     
if (Dia > 40.0)  pfol = 0.125; pb  = 0.183 

PY Pinyon Pine  Gr-92 LG See Pinyon Grier below 
JP Oneseed Juniper Gr-92 LG See Juniper Grier below 

 

Canopy Weight and Proportion Equation Codes: 

BK = Robert Keane, Missoula Fire Science Laboratory, Missoula, MT 

SR = Stephanie Rebain, Rocky Mountain Research Station, Moscow, ID 

LG = Larry Gangi, SEM LLC, Missoula, MT; TF = Tracy Frescino, Forest Inventory Analysis, Ogden, UT 

 

Most of the canopy weight and proportion equations used by FuelCalc were taken directly from 

previously written software programs written by BK and SR. The exceptions are the Pinyon/Juniper 

equations that were researched and implemented by LG and TF. 

 

Pinyon - Grier 1992, crown weight and proportion. Diameter (dia) is in centimeters, weight is in 

kilograms 

 
Bole w/bark    StemBark  = pow( 10.0,  (-2.588 + 2.955 * log10(diam)))   
Twigs < 2.5 cm   BraSml = pow( 10.0,  (-1.613 + 2.088 * log10(diam)))    
Foliage    TotFol = pow( 10.0,  (-0.946 + 1.565 * log10(diam)))   
Bole, branch & foliage  Total = pow( 10.0,  (-1.468 + 2.582 * log10(diam)))    
Available Crown Fuel   ACF = TotFol + (0.33 * BraSml)      
Total Crown Weight   CW = Total - StemBark;              
Proportion of Foliage  pfol = ( TotFol / CW ): if pfol > 0.95 ;  pfol = 0.95 
Proportion of Small Branch pb = ACF / CW: if pb > 0.95; pb = 0.95 

 

Juniper - Grier 1992, crown weight and proportion. Diameter (dia) is in centimeters, weight is in 

kilograms 

 
Bole w/bark    StemBark  = pow( 10.0, (-2.297 + 2.437 * log10(diam)) 
Twigs < 2.5 cm    BraSml    = pow( 10.0, (-1.476 + 1.787 * log10(diam)) 
Foliage – Young  FolYng  = pow( 10.0, (-1.358 + 1.841 * log10(diam)) 
Foliage – Mature  FolMat = pow( 10.0, (-0.862 + 1.399 * log10(diam)) 
Foliage – Average  Fol = (FolYng + FolMat) / 2.0         
Bole, branch & foliage  Total     = pow( 10.0, (-1.157 + 2.086 * log10(diam)) 
Availabel Canopy Fuel  ACF = Fol + ( 0.25 * BraSml )         
Total Canopy Weight  CW  = Total - StemBark                
Proportion of Foliage  pfol = ( Fol / CW ): if pfol > 0.95;   pfol = 0.95 
Proportion small branch pb  = ( ACF / CW ): if pb > 0.95;  pb = 0.95 

 

Canopy Weight and Proportion Equation Sources: 

 

Brn-78:  Brown, JK. 1978. Weight and Density of Crowns of Rocky Mountain Conifers. USDA Forest 

Service, Research Paper INT-197. 

 

SL-83:   Snell, J. A. and S. N. Little, 1983: Predicting Crown Weight and Bole Volume of Five Western 

Hardwoods.   PNW-GTR-151, 37 pp. 
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Gh-79:  Gholz, H. L., C. C. Grier, A. G. Campbell, and A. T. Brown. 1979. Equations for estimating biomass 

and leaf area of plants in the Pacific Northwest. Oregon State University, Forestry Research         

Laboratory, Research Paper 41 

 

Gr-92:  Grier. 1992. Biomass distribution and productivity of Pinus edulis-Juniperus monosperma 

woodlands of north-central Arizona, 50 (1992) 331-350 

 

Vertical Distribution Equations 

These equations are used to determine the amount of available canopy fuel that is contained in each 

layer of a tree's crown. 

 

Id  = FuelCalc two-letter species equation identifier 

Name = Common Name 

Equation = Equation as implemented in source code 

pw = Proportion of weight (available canopy fuel) 

ph = Fractional crown length (length from bottom crown ) / (total length of crown) 

 
Id   Name                      Equation 
PP   Ponderosa                 pw = (2.3637 * sqr(ph)) - (1.3637 * cube(ph)) 
WF   White Fir                 pw = ph; (uniform dist.) 
DF   Douglas Fir               pw = (2.3284 * sqr(ph)) - ( 1.3284 * cube (ph) ) 
LP   Lodgepole Pine            pw = (1.6045 * sqr(ph)) - ( 0.6045 * cube(ph)) 
IC   Incense/Western Red Cedar pw = (2.5395 * sqr(ph)) - (1.5395 * cube(ph)) 
PS   Ponderosa  SW             pw = (0.1251 * ph) + (2.8072 * sqr(ph)) - ( 1.9322 * cube(ph)) 

 

Vertical Distribution Equation Source: 

Based on: Reinhardt, E; Scott, J; Gray, K: Keane, R. 2006. Estimating canopy fuel characteristics in five 

conifer stands in the western United States using tree and stand measurements. Can. J. For. Res. 2803-

2814. 

The vertical distribution equations were calculated by Kathy Gray using biomass data obtained by 

destructively sampling trees of different species at 5 study sites.  To obtain the equations for the 

cumulative proportion of biomass at a given height, a nonlinear regression technique was used with 

proportion of crown as the independent variable and cumulative proportion of biomass as the 

dependent variable. 

 

See the section below on Calculating Canopy Bulk Density for details on how these equations are used to 

distribute biomass into each vertical layer. 
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Crown Class Adjustment Factors 

 

These factors are used to reduce a tree's crown weight based on its crown class. Dom.=Dominant, Co-

dom.=Co-dominant, Interm.=Intermediate, Supp.=Suppressed. 

Code Species Source1 Dom. Co-dom. Interm. Supp. Other/none 

WF White fir KG 0.85 0.85 0.35 0.3 0.5 
PP Ponderosa pine KG 0.55 0.55 0.3 0.15 0.5 

PS SW ponderosa pine KG 0.3 0.3 0.15 0.1 0.5 

IC Incense cedar KG 1.1 1.1 0.75 0.4 0.5 

DF Douglas-fir KG 1.15 1.15 1.15 0.75 0.5 

LP Lodgepole pine KG 0.6 0.6 0.6 0.3 0.5 

WL Western larch BK 1.0 0.45 0.3 0.2 0.5 

WP White pine BK 0.8 0.9 0.6 0.35 0.7 

WC Western redcedar BK 1.0 1.0 1.0 0.6 0.75 

GF Grand fire BK 0.65 0.7 0.35 0.55 0.5 

PJ Pinyon & juniper None 1.0 1.0 1.0 1.0 1.0 
1 Crown Class Adjustment Factor Sources: 

Kathy Gray (KG) - Reinhardt, E; Scott, J; Gray, K: Keane, R. 2006. Estimating canopy fuel characteristics in 

five conifer stands in the western United States using tree and stand measurements. Can. J. For. Res. 

2803-2814. Crown class factors were calculated by Kathy Gray to adjust the predicted biomass obtained 

from the equations for tree class.  The tree class adjustments reported were the multipliers that 

minimized the average difference between the observed biomass of the tree and the predicted biomass 

of a tree using the biomass equations.  The adjustments were applied to a tree by multiplying the 

predicted biomass by the specific adjustment for that particular tree class. 

 
Bob Keane (BK) - Keane, R.E., S.F. Arno, and J.K. Brown. 1989. Modeling cumulative fire effects in 
ponderosa pine/Douglas-fir forests. Ecology 71(1): 189-203. 
 
Keane, R.E., S.F. Arno, and J.K. Brown. 1989. FIRESUM -- an ecological process model for fire succession in 
western conifer forests. USDA Forest Service General Technical Report INT-266. 76 p. 
 
Keane, Robert E., Penelope Morgan, Steven W. Running.  1996. Fire-BGC – a mechanistic ecological 
process model for simulating fire succession on coniferous forest landscapes of the Northern Rocky 
Mountains. Res. Paper INT-484. Ogden, UT: U.S. Department of Agriculture Forest Service.        
Intermountain Research Station. 122 p. 
 
None - Currently there are no adjustment factors for Pinyon or Juniper so they are all set to 1.0. 

 

Newer Biomass Equations in FuelCalc 

This section contains new biomass formulas that have been added to the program. Existing FuelCalc 

vertical distribution formulas and canopy class factors needed to calculate canopy bulk density were 

then associated with each new species using a best-fit strategy. 
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The table below contains the species common names and the research papers from which their biomass 

formulas were taken. Most research papers contained only total crown and foliage biomass formulas; 

for these species, a best-fit twig biomass formula was chosen from the existing FuelCalc species 

formulas. Sources are identified below the table. 

 

Species Source 

Northeastern Red Oak Lom-81 

Balsam Fir Ker-108, twig Grand Fir Brn-78 

Atlantic White Cedar Ker-114, twig Western Redcedar Brn-78 

Black Spruce Ker-108, twig Grand Fir Brn-78 

Red Spruce             Fre-134, twig Grand Fir Brn-78 

Eastern White Pine      Ker-114, twig Grand Fir Brn-78 

Eastern Hemlock        Ker-114, twig Western Hemlock Brn-78 

Quaking Aspen-NS       Ker-108, twig Lom-78 

Quaking Aspen-MN     Lom-78 

Red Maple Fre-134, twig Bigleaf Maple SL-83 

Sugar Maple            Fre-134, twig Bigleaf Maple SL-83 

Yellow Birch Ker-114, twig Red Alder SL-83 

Paper Birch Ker-108, twig Red Alder SL-83, used Ker's White Birch 

Pitch Pine Duv-05 

Loblolly Pine         Rog-16, twig Lodgepole Pine Brn-78 

Giant Chinkapin       SL-83 

 

Sources for new species 

 

Lom-81: 

Loomis, Robert M., Blank, Richard W.  1981. Estimating northern red oak crown component weights in 

the Northeastern United States. Research Paper NC-194. St. Paul, MN; U.S. Dept. of Agriculture, Forest 

Service, North Central Forest Experiment Station 

 

Lom-78: Loomis, Robert M., Roussopoulos, Peter J. 1978. Estimating aspen crown fuels in northeastern 

Minnesota. Research Paper NC-156. St. Paul, MN; U.S. Dept. of Agriculture, Forest Service, North Central 

Forest Experiment Station. 

 

Ker-108: Ker, M.F.  1980. Tree Biomass equations for ten major species in Cumberland County, Nova 

Scotia.  Maritime Forest Research Centre. Fredericton, New Brunswick. Inf. Rep. M-X-108. Canadian 

Forestry Service, Environment Canada. 

 

Ker-114: Ker, M.F. 1980. Tree Biomass equations for seven species in southwestern New Brunswick. 

Maritime Forest Research Centre. Fredericton, New Brunswick, Rep. M-X-114, Canadian Forestry Service, 

Environment Canada 
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Fre-134: Freedman B, Duinker, and others. 1982. Forest biomass and nutrient studies in central Nova 

Scotia, Institute for Resource and Environmental Studies and Department of Biology, Dalhousie 

University, Halifax, Nova Scotia, B3H 4J1 Maritime Forest Research Centre Fredericton, New Brunswick, 

Report M-X-134 

 

Duv-05: Duveneck, Matthew J. 2005. Characterizing Canopy Fuels as They Affect Fire Behavior in Pitch 

Pine (Pinus Rigida). MS Thesis, University of Massachusetts Amherst 

 

Rog-16: Rogerson, T. 1964. Estimating foliage on loblolly pine. Res. Note SO-16. New Orleans, LA: U.S. 

 

Brn-78:  James K. Brown. 1978. Weight and Density of Crowns of Rocky Mountain Conifers, , USDA Forest 

Service, Research Paper INT-197. 

 

SL-83:   Snell, J. A. and S. N. Little, 1983. Predicting Crown Weight and Bole Volume of Five Western 

Hardwoods.   PNW-GTR-151, 37 pp. 

 

Default Equation Table 

The equation assignments stored in the internal table are displayed in the table below. The Incl. CBD 

column indicates whether or not crown and bole biomass for the associated species will be included in 

the crown biomass totals. By default, for hardwoods the field is set to No. You can modify the default 

setting by creating a custom equation file as described in Appendix C. Two-letter abbreviations are 

defined in the Crown weight equations, Crown weight proportion equations (foliage and small branch), 

Vertical distribution and Crown class adjustment factors sections above. 

 

Common 
Name 

Incl. 
CBD Total Fol. Twig 1” 3” 3”+ 

Vert. 
Dist. 

Crown 
Reduc. 

Red Alder  No RA RA RA RA RA RA UN DF 

White Alder No RA RA RA RA RA RA UN DF 

Alaska Cedar Yes WC WC WC WC WC WC IC IC 

Incense Cedar Yes WC WC WC WC WC WC IC IC 

Western Redcedar  Yes WC WC WC WC WC WC IC IC 

Douglas Fir  Yes DF DF DF DF DF DF DF DF 

Grand Fir  Yes GF GF GF GF GF GF DF WF 

Noble Fir Yes GF GF GF GF GF GF DF WF 

Pacific Silver Fir Yes GF GF GF GF GF GF DF WF 

Subalpine Fir  Yes SF SF SF SF SF SF DF WF 

White Fir Yes GF GF GF GF GF GF DF WF 

Mountain Hemlock Yes WH WH WH WH WH WH DF DF 

Western Hemlock   Yes WH WH WH WH WH WH DF DF 

Rocky Mountain Juniper  Yes JP JP JP JP JP JP DF PJ 

Utah Juniper Yes JP JP JP JP JP JP DF PJ 
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Subalpine Larch Yes WL WL WL WL WL WL DF WF 

Western Larch  Yes WL WL WL WL WL WL PP PP 

Madrone  No MA MA MA MA MA MA UN DF 

Mountain Maple No BM BM BM BM BM BM UN WF 

Tanoak  No TO TO TO TO TO TO UN DF 

Bristlecone Pine Yes LP LP LP LP LP LP LP LP 

Jeffrey Pine Yes PP PP PP PP PP PP PP PP 

Limber Pine Yes LP LP LP LP LP LP PP PP 

Lodgepole Pine   Yes LP LP LP LP LP LP LP LP 

Ponderosa Pine  Yes PP PP PP PP PP PP PP PP 

Ponderosa Pine SW Yes PP PP PP PP PP PP PS PS 

Sugar Pine Yes PP PP PP PP PP PP PP PP 

Western White Pine  Yes WP WP WP WP WP WP LP LP 

Whitebark Pine  Yes WB WB WB WB WB WB LP LP 

Colorado Pinyon  Yes PY PY PY PY PY PY DF PJ 

Coast Redwood Yes WC WC WC WC WC WC DF DF 

Giant Sequoia Yes WC WC WC WC WC WC DF DF 

Blue Spruce Yes ES ES ES ES ES ES DF DF 

Brewer Spruce Yes ES ES ES ES ES ES DF DF 

Engelmann Spruce  Yes ES ES ES ES ES ES DF WF 

Sitka Spruce Yes ES ES ES ES ES ES DF DF 

White Spruce Yes ES ES ES ES ES ES DF DF 

Pacific Yew Yes WC WC WC WC WC WC DF WF 

Quaking Aspen  No QA QA QA BM BM BM UN WF 

Paper Birch  No PB PB PB RA RA RA UN DF 

Yellow Birch  No YB YB YB RA RA RA UN DF 

Atlantic White Cedar  Yes AC AC AC WC WC WC IC IC 

Balsam Fir  Yes BF BF BF GF GF GF DF WF 

Eastern Hemlock  Yes EH EH EH WH WH WH DF DF 

Red Maple  No RM RM RM BM BM BM UN WF 

Sugar Maple  No SM SM SM BM BM BM UN WF 

Calif Black Oak No TO TO TO TO TO TO UN DF 

Giant Chinkapin Oak  No GC GC GC GC GC GC UN DF 

Northern Red Oak  No RO RO RO GC GC GC UN DF 

Eastern White Pine  Yes EP EP EP DF DF DF DF DF 

Loblolly Pine  Yes LO LO LO DF DF DF DF PP 

Pitch Pine  Yes PI PI PI PP PP PP PP PP 

Black Spruce  Yes BS BS BS DF DF DF DF DF 

Red Spruce  Yes RS RS RS DF DF DF DF DF 
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Small Tree Biomass Equations 

 

When tree dbh <1” FuelCalc uses biomass calculated with equations from Brown, J.K. 1978. Weight and 

Density of Crown of Rocky Mountain Conifers. Res. Pap. INT-RP-197. Ogden, UT: U.S. Department of 

Agriculture, Forest Service, Intermountain Forest and Range Experiment Station. 56 p. 

 

The tables below were created by first calculating whole tree weight using the equations in Brown 1978, 

table 6 (equations for predicting whole tree weight for trees <15’ tall) and then calculating the 

component biomass using the equations in Brown 1978, table 19 (equations for predicting proportion of 

foliage and branch material for tree <15’ tall). Component biomass for trees with dbh <1” and greater 

than 10’ tall are set at the values for a 10’ tree (Wt = lbs/tree).  

 

 

 

 

 
 

 

1 foot 2 feet 3 feet 

Species Total Wt* Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt

Douglas-fir 0.030 0.011 0.005 0.011 0.002 0.000 0.200 0.076 0.036 0.076 0.012 0.000 0.560 0.213 0.101 0.213 0.034 0.000

Ponderosa pine 0.030 0.011 0.005 0.011 0.002 0.000 0.200 0.076 0.036 0.076 0.012 0.000 0.560 0.213 0.101 0.213 0.034 0.000

Spruce 0.030 0.015 0.006 0.007 0.002 0.000 0.200 0.102 0.042 0.046 0.010 0.000 0.560 0.286 0.118 0.129 0.028 0.000

Subalpine fir 0.030 0.015 0.006 0.007 0.002 0.000 0.200 0.102 0.042 0.046 0.010 0.000 0.560 0.286 0.118 0.129 0.028 0.000

Wester white pine 0.060 0.029 0.013 0.018 0.001 0.000 0.250 0.120 0.053 0.075 0.003 0.000 0.610 0.293 0.128 0.183 0.006 0.000

Grand fir 0.060 0.031 0.013 0.014 0.003 0.000 0.250 0.128 0.053 0.058 0.013 0.000 0.610 0.311 0.128 0.140 0.031 0.000

Whitebark/Limber pine 0.060 0.016 0.014 0.023 0.008 0.000 0.250 0.065 0.058 0.095 0.033 0.000 0.610 0.159 0.140 0.232 0.079 0.000

Western red cedar 0.020 0.010 0.004 0.005 0.001 0.000 0.130 0.066 0.027 0.030 0.007 0.000 0.340 0.173 0.071 0.078 0.017 0.000

Western larch 0.020 0.005 0.005 0.008 0.003 0.000 0.130 0.034 0.030 0.049 0.017 0.000 0.340 0.088 0.078 0.129 0.044 0.000

Lodgepole pine 0.020 0.008 0.004 0.008 0.001 0.000 0.130 0.049 0.023 0.049 0.008 0.000 0.340 0.129 0.061 0.129 0.020 0.000

Western hemlock 0.010 0.004 0.002 0.004 0.001 0.000 0.050 0.019 0.009 0.019 0.003 0.000 0.160 0.061 0.029 0.061 0.010 0.000

4 feet 5 feet 6 feet

Species Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt

Douglas-fir 1.180 0.448 0.212 0.448 0.071 0.000 2.090 0.648 0.293 0.481 0.669 0.000 3.330 1.032 0.466 0.766 1.066 0.000

Ponderosa pine 1.180 0.448 0.212 0.448 0.071 0.000 2.090 0.648 0.293 0.481 0.669 0.000 3.330 1.032 0.466 0.766 1.066 0.000

Spruce 1.180 0.602 0.248 0.271 0.059 0.000 2.090 0.836 0.334 0.355 0.543 0.000 3.330 1.332 0.533 0.566 0.866 0.000

Subalpine fir 1.180 0.602 0.248 0.271 0.059 0.000 2.090 0.836 0.334 0.355 0.543 0.000 3.330 1.332 0.533 0.566 0.866 0.000

Wester white pine 1.150 0.552 0.242 0.345 0.012 0.000 1.870 0.580 0.299 0.337 0.655 0.000 2.780 0.862 0.445 0.500 0.973 0.000

Grand fir 1.150 0.587 0.242 0.265 0.058 0.000 1.870 0.748 0.299 0.318 0.486 0.000 2.780 1.112 0.445 0.473 0.723 0.000

Whitebark/Limber pine 1.150 0.299 0.265 0.437 0.150 0.000 1.870 0.393 0.355 0.486 0.636 0.000 2.780 0.584 0.528 0.723 0.945 0.000

Western red cedar 0.690 0.352 0.145 0.159 0.035 0.000 1.170 0.468 0.187 0.199 0.304 0.000 1.820 0.728 0.291 0.309 0.473 0.000

Western larch 0.690 0.179 0.159 0.262 0.090 0.000 1.170 0.246 0.222 0.304 0.398 0.000 1.820 0.382 0.346 0.473 0.619 0.000

Lodgepole pine 0.690 0.262 0.124 0.262 0.041 0.000 1.170 0.363 0.164 0.269 0.374 0.000 1.820 0.564 0.255 0.419 0.582 0.000

Western hemlock 0.350 0.133 0.063 0.133 0.021 0.000 0.640 0.198 0.090 0.147 0.205 0.000 1.050 0.326 0.147 0.242 0.336 0.000

7 feet 8 feet 9 feet

Species Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt

Douglas-fir 4.940 1.531 0.692 1.136 1.581 0.000 6.950 2.155 0.973 1.599 2.224 0.000 9.390 2.911 1.315 2.160 3.005 0.000

Ponderosa pine 4.940 1.531 0.692 1.136 1.581 0.000 6.950 2.155 0.973 1.599 2.224 0.000 9.390 2.911 1.315 2.160 3.005 0.000

Spruce 4.940 1.976 0.790 0.840 1.284 0.000 6.950 2.780 1.112 1.182 1.807 0.000 9.390 3.756 1.502 1.596 2.441 0.000

Subalpine fir 4.940 1.976 0.790 0.840 1.284 0.000 6.950 2.780 1.112 1.182 1.807 0.000 9.390 3.756 1.502 1.596 2.441 0.000

Wester white pine 3.880 1.203 0.621 0.698 1.358 0.000 5.190 1.609 0.830 0.934 1.817 0.000 6.710 2.080 1.074 1.208 2.349 0.000

Grand fir 3.880 1.552 0.621 0.660 1.009 0.000 5.190 2.076 0.830 0.882 1.349 0.000 6.710 2.684 1.074 1.141 1.745 0.000

Whitebark/Limber pine 3.880 0.815 0.737 1.009 1.319 0.000 5.190 1.090 0.986 1.349 1.765 0.000 6.710 1.409 1.275 1.745 2.281 0.000

Western red cedar 2.640 1.056 0.422 0.449 0.686 0.000 3.650 1.460 0.584 0.621 0.949 0.000 4.840 1.936 0.774 0.823 1.258 0.000

Western larch 2.640 0.554 0.502 0.686 0.898 0.000 3.650 0.767 0.694 0.949 1.241 0.000 4.840 1.016 0.920 1.258 1.646 0.000

Lodgepole pine 2.640 0.818 0.370 0.607 0.845 0.000 3.650 1.132 0.511 0.840 1.168 0.000 4.840 1.500 0.678 1.113 1.549 0.000

Western hemlock 1.600 0.496 0.224 0.368 0.512 0.000 2.310 0.716 0.323 0.531 0.739 0.000 3.180 0.986 0.445 0.731 1.018 0.000

10 feet

Species Total Wt Fol Wt 1hr Wt 10hr Wt 100hr Wt 1k hr Wt

Douglas-fir 12.300 3.321 1.353 2.337 3.690 1.599

Ponderosa pine 12.300 3.321 1.353 2.337 3.690 1.599

Spruce 12.300 4.059 1.476 2.214 3.567 0.984

Subalpine fir 12.300 4.059 1.476 2.214 3.567 0.984

Wester white pine 8.430 2.108 1.012 1.265 3.119 0.927

Grand fir 8.430 2.782 1.012 1.517 2.445 0.674

Whitebark/Limber pine 8.430 1.265 1.180 1.349 3.709 0.927

Western red cedar 6.240 2.059 0.749 1.123 1.810 0.499

Western larch 6.240 0.936 0.874 0.998 2.746 0.686

Lodgepole pine 6.240 1.685 0.686 1.186 1.872 0.811

Western hemlock 4.240 1.145 0.466 0.806 1.272 0.551
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Canopy Cover 

Canopy Cover is calculated using crown width equations, which are then converted to crown area. The 

equations use species specific coefficients (see table below). Once crown cover is calculated for 

individual trees and then accumulated for the treelist, an overlap correction factor is applied.  

Equation for trees over 4.5 feet: 

CW = A * DB  

where;  

CW = Crown Width (ft) 

A    = A Coefficient 

D    = Diameter (in.) 

B    = B Coefficient 

 Equation for trees under 4.5 feet: 

CW = R * D   

where;  

CW = Crown Width (ft)  

R    = Ratio Coefficient  

D    = Diameter (in.) 

See the FOFEM tree species file (FOF_SPP.CSV) in the installation folder for more information. 

The overlap calculation is: 

CovProp = (Cov / 43560) 

PctCov  = 100.0 * ( 1.0 -  expCovProp)  

where;  

CovProp = Proportion of each acre with crown cover 

Cov          = Total accumulated crown cover (ft2) 

PctCov    = Percent crown cover adjusted for overlap (ac-1) 

Coefficients for tree crown widths are based on data from R6 Permanent Plot Grid Inventory. 

Eq no. Species 
Code 

A Coeff. B Coeff. Ratio 
Coeff. 

1 "SF" 3.9723 0.5177 0.473 

2 "WF" 3.8166 0.5229 0.452 

3 "GF" 4.187 0.5341 0.489 

4 "AF" 3.2348 0.5179 0.385 

5 "RF" 3.1146 0.578 0.345 

7 "NF" 3.0614 0.6276 0.32 

8 "YC" 3.5341 0.5374 0.331 
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9 "C" 4.092 0.4912 0.412 

10 "S" 3.6802 0.494 0.412 

11 "LP" 2.4132 0.6403 0.298 

12 "JP" 3.2367 0.6247 0.406 

13 "SP" 3.061 0.6201 0.385 

14 "WP" 3.4447 0.5185 0.476 

15 "PP" 2.8541 0.64 0.407 

16 "DF" 4.4215 0.5329 0.517 

17 "RW" 4.4215 0.5329 0.517 

18 "RC" 6.2318 0.4259 0.698 

19 "WH" 5.4864 0.5144 0.533 

20 "MH" 2.9372 0.5878 0.253 

21 "BM" 7.5183 0.4461 0.815 

22 "RA" 7.0806 0.4771 0.73 

23 "WA" 7.0806 0.4771 0.73 

24 "PB" 5.898 0.4841 0.601 

25 "GC" 2.4922 0.8544 0.14 

26 "AS" 4.091 0.5907 0.351 

27 "CW" 7.5183 0.4461 0.815 

28 "WO" 2.4922 0.8544 0.14 

29 "J" 4.5859 0.4841 0.468 

30 "LL" 2.1039 0.6758 0.207 

31 "WB" 2.1606 0.6897 0.255 

32 "KP" 2.1451 0.7132 0.248 

33 "PY" 4.5859 0.4841 0.468 

34 "DG" 2.4922 0.8544 0.14 

35 "HT" 4.5859 0.4841 0.468 

36 "CH" 4.5859 0.4841 0.468 

37 "WI" 4.5859 0.4841 0.468 

38 "" 4.4215 0.5329 0.517 

 

Calculating Canopy Bulk Density 

 

Six basic steps are required to calculate canopy bulk density (CBD), canopy base height (CBH) and stand 

height (SH): 

 

• Calculate a tree's total canopy weight (CW). 

• Adjust the CW by applying the appropriate canopy class factor. 

• Calculate available canopy fuel (ACF) from CW. 

• Vertically distribute ACF into canopy layers. 

• Repeat steps 1 to 4 for each tree and accumulation calculated values. 

• Examine layers to determine CBD, CBH and SH. 
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1. Calculate the tree's total CW by using the Canopy Weight equation. Weight equations are species-

specific, although some species use the same equation. Most weight equations are based on tree       

diameter, but a few equations include a crown ratio. 

 

2. Adjust the calculated CW by applying the appropriate Canopy Class Factor according to the tree's 

canopy class (for example, dominant, codominant, etc.). 

 

3. Calculate ACF using Proportion Equations. 

Current equations in use are entirely based on tree diameter. 

 

ACF = (pfol * CW) + ( (pb * CW) * 0.5) 

ACF = weight of foliage plus fifty percent of small branch 

pfol = percent of foliage 

pb  = percent of small branch 

small branch = less than 1/4 inch in diameter, sometimes referred to as twig 

 

4. Vertically distribute the ACF into a crown layer array 

For each layer [i] in the crown 

CLA[i] = (ACF * (pw (ph([i+1])))) - (ACF * (pw (ph([i])))) 

CLA[] = crown layer array 

i = layer index, i-th layer in crown 

ph =  the height from the bottom of the crown up to the specified i-th layer, expressed as a 

percentage of total crown height 

pw = percentage of total crown weight from the bottom of crown up to the specified percentage 

in height (ph) 

 

Total crown height is the distance from the bottom of the crown to the top of the crown. 

 

With the formula above, determining the ACF for layer[i] can be accomplished by calculating the ACF 

once for a height at the top layer[i] and once for height at the bottom of layer[i], then taking the 

difference to get the amount of ACF in layer[i]. Repeating this process for each layer in the tree crown 

results in the ACF for every layer. 

 

Example to illustrate getting the ACF for layer 4: 

i = 4 

  Layer width = 1 foot 

   Total crown height = 20 feet 

   ACF = 200 pounds 

   Vertical distribution equation: 

      PP Ponderosa   pw = ( 2.3637 * sqr(ph)) - (1.3637 * cube(ph)) 
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Initial Formula: 

CLA[i] = (ACF * (pw (ph([i+1])))) - (ACF * (pw (ph([i])))) 

 

The bounds of the 4th layer are 4 and 5 feet, 

The initial formula with layer heights inserted is 

CLA[4] = (200 * (pw (ph(5)))) - (200 * (pw (ph(4)))) 

 

Then the percentage in height that 5 feet is of a 20 foot crown is ph(5) or 0.25 

 

Next the percentage of weight from bottom of crown to 5 feet is pw(0.25) 

And using our PP Ponderosa equation and inserting 0.25. 

pw = ( 2.3637 * sqr(ph))   - (1.3637 * cube(ph)) 

0.13 = ( 2.3637 * sqr(0.25)) - (1.3637 * cube(0.25)) 

 

Now multiply the percentage times ACF to get the predicted ACF from the bottom of the crown 

to a height of 5 feet. 

26 pounds = 0.13 * (200 pounds) 

 

Repeating the process for 4 feet, the height at the bottom for the 4th layer, obtains 16 pounds. 

 

Finally take the difference of the two calculations (26-16), yielding 10 pound,s which is the ACF in 

the 4th layer. 

 

5. Repeat steps 1 through 4 for each tree to accumulating the CW and the ACF in the each crown layer. 

6. Determine the maximum CBD, canopy base height (CBH) and stand height (SH) by examining the 

weight assigned to each layer in step 3. 

      CBD is the maximum value found, expressed as kilograms per cubic meter (kg/m3) 

      CBH is the height of the lowest layer containing a minimum value of 0.012 kg/m3. 

      SH is the height of the highest layer containing a minimum value of 0.012 kg/m3. 

 

If CBD < 0.012, then CBH and SH are the lowest and highest layer, respectively, that exceed CBD*0.1. 

 

Notes:  Dead trees are not and should not be included in any type of FuelCalc's input; 

accordingly, they are not used in any calculations. 

Hardwood tree crown weights are not included in ACF; therefore, they are not used to 

calculate CBD, CBH and SH. Hardwood trees can be included in canopy fuel calculations 

by setting the Inc CBD field to “Yes” in the sample-species.csv file.  

 

 

 



FuelCalc User’s Guide   

82 
 

Canopy cover equation citation 

Crookston, N.L. and Stage, A.R. 1999. Percent canopy cover and stand structure statistics from the Forest 

Vegetation Simulator. Gen. Tech. Rep. RMRS-GTR-24. Ogden, UT: U. S. Department of Agriculture, Forest 

Service, Rocky Mountain Research Station. 11 p. 

Appendix E:  FuelCalc Command Line Batch 

FuelCalc can be run from the command line. Four input files are required. Examples of all these input 

files are provided with the installer and can be found in C:\Users\username\AppData\Local\FuelCalc. 

Description File format Example 

.FFI files  Comma delimited format FFI_Sample.ffi 

.TRE files with macro plots and tree data Comma delimited format FFI_Sample.tre 

Treatment file Comma delimited format CLB_Treatment.csv 

Project file Space delimited format FC_Sample.fcp 

 

File Descriptions 

.FFI  

 Includes macro plot names and fuels data. Described in Appendix A.  

.TRE  

Includes macro plots names and tree data. Described in Appendix A. 

Treatment file 

Includes a row for each macro plot. The fields in the table below are required for each macro plot. If the 

file is created using the Options>Treatment File menu item the file will be name Link-Treatment.csv. 

 

Field Name Description 

Plot Macro plot name. Must correspond to a macro plot name in the .FFI and .TRE files 

RetPri Retention Priority settings. Must correspond to a Retention Priority set described 
in the FuelCalc Project file  

Treatment Treatment settings. Must correspond to a Treatment set described in the FuelCalc 
Project file 

Thin Is a thinning treatment to be simulated? Valid values: Yes or No 

Prune Is a pruning treatment to be simulated? Valid values: Yes or No 

Pile Is a piling treatment to be simulated? Valid values: Yes or No 

Burn Is a burning treatment to be simulated? Valid values: Yes or No 
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Project file 

The file has a .FCP extension and it includes all information saved from the user interface including 

settings for Retention Priorities, Treatments, Thinning, Prune, Broadcast Burn, Pile and Fuel Model 

Selector. The Retention Priorities and Treatments listed in the Treatment file must be defined in the 

Project file. 

Running a simulation from the DOS window 

Before running FuelCalc from a DOS window move all input files described above into a common 

directory using Windows Explorer or My Computer. This directory can be created in any location.  

Open a DOS window. The easiest way to do this is type CMD in the Windows Search window and hit 

Enter. A DOS or command window will open. 

Use the DOS Path command to identify the directory where FC_GUI.EXE is saved. If using the default 

installation this is the Path command to use (DOS commands are not case sensitive):  

set path=%path%;c:\program files (x86)\fuelcalc1.6 

Change the directory to the where your input files are located. For example, if the input files are stored 

in C:\Fuelcalc_DOS type this command at the DOS prompt: 

cd c:\fuelcalc_dos 

Two output files are created by FuelCalc; their names must be included in the DOS command used to 

run FuelCalc. The Output filename must have a .csv extension and the Error/Warning filename a .txt 

extension. 

The DOS command format for running FuelCalc is: 

FC_GUI FFI_file TRE_file Treatment_file Project_file Output_file 

Error/Warning_file 

NOTE: Don’t include spaces in filenames 

Example DOS command to execute FuelCalc (the four input files are included with the FuelCalc installer 

file):  

fc_gui ffi_sample.ffi ffi_sample.tre clb_treatment.csv fc_sample.fcp 

fc_dos_output.csv fc_dos_error.txt 

When FuelCalc runs it will create the Output and Error files and put them in the same directory as the 

input files. Check the Error files for issues. 

A text file named FuelCalc_CLB.txt will be created and saved in the active directory. This file will tell you 

if the simulation ran (Success) or failed to run (Error). Even when FuelCalc runs successfully you should 

check the error/warning file. For example, there is no field in FFI for sapling crown class so you will see a 
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warning for every sapling run through FuelCalc that states the tree record was given a crown class of 

None. Warnings do not stop the simulation – they are just reported for information. Errors will stop the 

simulation. 

Example Project file 

The example is reproduced from Sample_CLB_Project.fcp, which is included with the FuelCalc 

installation files. 

# ======================================================================================== 

# This is a sample .fcp (project) file for running a FuelCalc Command Line Batch  

# Lines starting with a # followed by a blank character are comments 

# Lines starting with a # not followed by a blank character are switches 

# Switches are space delimited. Do not use blank characters in names or descriptions  

# The switches in this file are a subset of those found in a FuelCalc project file 

# All of the switches in this file are required when running FuelCalc from the command line 

# ======================================================================================== 

# Canopy Bulk Density threshold - see FuelCalc User Guide for details 

#CBDThreshold 0.012 

# ---------------------- 

# Species Retention Priority Groups - define all groups used in the #RetPri below 

# Number consecutively starting with -0 

#              Name       Species   min max dbh   Ret Pri 

#Species-0 All        _Other       0       100          99 

#Species-1 PIPO     PIPO          0       100          99 

#Species-2 PIPO    _Other       0       100          0.5 

# ---------------------- 

# Retention Priority 

# Number consecutively starting with -0 

#             Name     Description                                                        Priorities – see Retention Priorities               Species Group 

#RetPri-0 None    Has_no_influence                           1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0   All 

#RetPri-1 Low      Default_Low_Thinning                   1.0 0.7 0.2 0.0 1.0 0.9 0.6 1.0 0.1 1.0 1.0 0.5 0.6 0.8   All 

#RetPri-2 High     Default_High_Thinning                  1.0 0.7 0.2 0.0 0.4 0.5 1.0 0.1 1.0 1.0 1.0 0.5 0.6 0.6   PIPO 

#RetPri-3 Diam    Default_diameter_limit_harvest 1.0 0.1 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 0.5 1.0 0.1 _None 

# ---------------------- 

# Treatments number consecutively starting with -0  

# The 10-hr moisture value is used for Broadcast burning AND calculating torching and crowing indexes 

# See the BCBMoist setting below  

#                       Name       Treat. Type               Treatment settings - see Treatments 

#Treatment-0 Restore    TreeDensity    200 90 4 2 20 0 8 0 0 0 0 0 10 12 14 30 InteriorWest Summer  

# ---------------------- 

# This setting will only be used if there is no 10 Hour moisture value specified in the plot's assigned treatment 

#BCBMoist Dry  

# ---------------------- 

# Fuel Model Selector   

#FMSModel All  

#FMSClimate Arid  

#FMSBedDep  20.0000 

#FMSSAVGra 1800.0000 

#FMSSAVShu 1500.0000 
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#FMSSAV1Hr 2000.0000 

 

The 10-hr moisture setting in the Treatment file is used to set the moisture levels input to Nexus for 
calculating crowning and torching index.  

 Percent Moisture used in Nexus 

Moisture, 10-hr (%) 1-hr 10-hr 100-hr Live Herb Live Shrub Foliar5 

0 < 61  3 4 5 30 60 100 

6 < 102  6 7 8 60 90 100 

10 < 163 9 10 11 90 120 100 

>164  12 13 14 120 120 100 

1 Dead fuel moisture = D1 and live fuel moisture = L1; in Scott and Burgan 2005 
2 Dead fuel moisture = D2 and live fuel moisture = L2; in Scott and Burgan 2005 
3 Dead fuel moisture = D3 and live fuel moisture = L3; in Scott and Burgan 2005 
4 Dead fuel moisture = D4 and live fuel moisture = L4; in Scott and Burgan 2005 
5 Nexus suggested default 

Appendix F:  Significant Version Changes 

• Version 1.1: Added torching and crowning index calculations, added torching and crowning 

index into summary reports. 

• Version 1.2: Added biomass equations for small trees (<1” DBH), modified batch run to allow 

stop/abort, modified installation folders for better performance in Windows 7 and Windows 8.   

• Version 1.3: Added Crown Ratio field in TRE file and command line batch functionality. 

• Version 1.4: Includes FOFEM 6.3.1 updates. Added command line batch. 

• Version 1.5: Includes FOFEM 6.4 updates. 

• Version 1.6: Includes FOFEM 6.5 updates, except bole char equations have not been added. 

• Version 1.7: Minor bug fixes. 


